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1

Vissim Introduction

This chapter is meant to familiarize a user with the Vissim interface. There
are tool bars, windows, and lists that can be customized and repositioned |
to suit the user's needs.

11 Interface Overview
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No | Name

Description |

1 Title Bar

e Program Name o Keep consistency. ,|
Using different versions .|
. . and service packs may ,
Project Directory affect calibration. |

e Version-Service Pack

2 Menu Bar

Call program functions. Edit/adjust internal conﬁgurations_';
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and assumptions.
Tool Bar Quick access to specific functions
Network e The visual interface | ¢ Incorporates internet
Editor between the user and background maps
Windows the network (2D only)
e Canbein 2D or3D ¢  Window can be separated
e Multiple can be open from the interface
Network o List of object layers o Generally working top
Object e Has buttons for down produces efficient
Window(s) turning layers on/off, coding
locking layers, and | ¢ Window can be separated
showing labels from the interface
List e Everyobjecthas alist | ¢ Lists display attributes
Windows e Lists show all objects | ¢  Are synchronized with the
of a specific type network editor windows
Quick View | ¢ Shows attributes of | ¢ Quickly edit a selected
Window the selected object object
111 Title Bar

|

=@

* ]

The title bar displays what version of Vissim is being run and what service
pack is being used,; in this image it is Vissim 8 and service pack 6.

[m PTV Vissim (x64) 8.00-06 - Network: F\Chapter 1\Interface\Interface.inpx

Versions are major releases generally released annually where new
functions, modules and add-ons are implemented.

Service Packs are released more frequently and provide updates and bug
fixes to the software.

New features, modules, or bug fixes may alter internal assumptions or
methods and thus change the calibrated model results. For this reason it is
important to maintain consistency with the version and service pack on a
particular model after calibration.

© PTV Group 2017 2




11.2 Menu Bar

'?Ie Edit View Lists BaseData Traffic Signal Control Simulation Evaluation Presentation Test Scripts Help ‘

_J\
Y Y
Interface Layout Model Data
Options
File & Edit

e Save/Open Network Files (*.inpx)

e Save/Open Layout Files (*.layx)

e Import/Export

o Set global parameters
View & Lists menus open various windows within the Interface.
Base Data provides access to background inputs and assumptions.

Traffic provides access to demand inputs and configurations.

Signal Control provides access to the signal
controllers’ logic. Signal Optimization

Simulation allows for configuring the details of The optimization is

a simulation; duration, resolution, speed, etc. designed for the
Stage-Based Fixed

Time Controllers
primarily used in
Presentation provides visualization tools in Europe.

either 2D (*.ani) or 3D (*.avi). — e

Test allows you to observe signal controller functionality and detector
settings without the computational overhead of a full simulation.

Evaluation is where the user defines what
data is collected and how to report it.

Scripts allows you to attach externally created subroutines to bypass
Vissim’s internal functionality

Help is where resources can be found to aid in building or running a
network such as example file, manuals, or links to online content.

3 © PTV Group 2017



1.4.3 Tool Bar

DBEB. O A & . » M B! NetvworkEditor v
H_J H_/ J\ J
Y Y
New, Open, Save Refresh Rate Simulation Controls  Currently selected window
Undo/Redo Quick Modes

The tool bar provides access to shortcut buttons for accomplishing certain
function quickly such as saving, running a simulation or changing how
often your display updates during a simulation.

11.4 Network Editor Tool Bar

Network Editor

Select layout... PRO OHH WA BAQ== Wi 7 @ (RB

\ J\(J W_/ \f/ \/
Load Pre- Saved Settings 2D Graphics Zoom Options 3D Camera 3D Graphics

Control

The network editor tool bar gives you the ability to manipulate the views
and graphic parameters within the network editor.

115 Network Settings (Global Parameters)

To open the network settings window open the Base Data menu and
select Network Settings. Network settings Trile Edit View Lists Base Dats
change global assumptions within the model #4 Network Settings

such as how gradients are calculated or what
units are used in the model.

) User-Defined Attributes

Vissim is unique in-that these ||[F @ ruemmsemi
settings can be changed at any time. P i
@ Uselink a! ute “gradient”
The two most commonly used tabs o Cauttd - conndintes
are Vehicle Behaviors and Units. T cgolations
©. Right-hand traffic
Vehicle Behavior Tab ”“’"“‘“‘““'“‘Gv
Specific power forH = ——
This tab defines which side of the e ;z x:
road vehicles can drive on, how ||| . "
grades are calculated (from [ Oring simlator st
geometry or from user-defined i ype
values), and power assumptions for
heavy  trucks  (impacts their
————
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performance on steep grades).
Units Tab

This tab defines what units are to
be displayed for each value

Vehicle Behavior | Pedestrian B

(length, speed and acceleration). ||| [ Aumest | teoo e~
Units can be changed to all |||[-2mee ] .

Speed:

Imperial (ft, in, miles, etc) or all
Metric (m, km, etc) by clicking the
respective buttons.

Alternatively the individual values
may be changed using the drop-
down menus. For example length
can be in miles, feet and inches but
speeds can be in km/h.

To learn more about the other tabs | i

please consult the Vissim user manual chapter 5.

1.1.6 Windows

Vissim’s interface is laid out with a series of different windows; Network
objects, Network Editor, Quick View, etc. These windows can be detached '
from their default positions and rearranged to meet the specific modeler’'s
needs.

To detach a window follow these steps:

1. Left-click and Hold the blue bar at the top of the window
2. Drag the window to the desired location
3. Release left-click

The windows can float independently of the program or they can be
docked into specific locations. If a window is detached from Vissim and ¢
dragged either to the center of another window or to the edge of another
window, an indicator will appear providing some options;

The center provides these options

I ,__1,,,_“ 1. ' Dock the selected window over the top of
I l: IE ‘ this window in a tabular format.
e —

2. ‘v- ‘ Dock the selected window to the right of

this window (or left, top, or bottom).

5 © PTV Group 2017



The arrows on the edges are similar to option 2 above however they allow
the selected window to be docked on the side, top or bottom of the entire
interface adjusting all other windows appropriately.

ﬁm Vimm 0:64) &(XH)G =Ls
}Flle Edit View Lists BaseData Traffic Signal Control Sumulahon Eva!uahon Presentahon Test Scripts Help l
ol 2iadF———a@ *Ip M ?]NewokEditor cid e 7
Network Edutor |

% Select layout... - ’m . (—) ’:- 3 < 7_5 & ‘& a [

Network Objects X ﬁ :
we| Links i |

Desired Speed Decisions
Reduced Speed Areas
Conflict Areas

4
3
|
a
El
3
]

Stop Signs
Signal Heads

D_._

Detectors

Vchlcl:!nputs
Vehicle Routes

|
|
I
|
1

i‘

Parking Lots
Public Transport Stops
Publlc Transport Lmes

Nodes

—0EX00

Data Collection Points
Vehicle Travel Times ,‘ [2
Queue Counters ‘

Sectlons

0

Background lmages

L

3D Traffic Signals
Static 30 Hodels

o Vehlcles In Netuork

——
= |

Pedesmans In Neh jork

A:eas

]

Obstacles

-
-

Ramps & Stairs
Pedestrian Inputs L]
Pedestrian Routes

gstem initialized! - | 2'

c o
=

Pedestrian Travel Times o

11.7 Layouts

Once the interface is configured as desired these settings may be saved
as a layout. Layouts offer the ability to view the model in different ways
without the overhead of manually reconfiguring the network each time.

Keep in mind using different layouts will not affect results data or
calibration in any way.

© PTV Group 2017 6



Perhaps there is one layout for network building, another for calibration
and a third for evaluation runs. Each layout can be loaded when
appropriate to quickly reconfigure the interface thus saving time manually
reconfiguring and improving workflow efficiency and consistency.

Saving a Layout

The current configuration of windows can be saved as a layout file (*.layx)
in the file menu. The *layx file is saved in the project directory (same file
location on the hard drive or server where the model is saved).

To save a layout file follow these steps;
1. Open the File menu
2. Select Save Layout As...
3. Windows explorer will open. Name the layout file.
4. Click Save to save the file.
To open a pre-existing layout file follow these steps;
1. Open the File menu
2. Select Open Layout...
3. Windows explorer will open. Select the layout file.
4. Click Open to open the file.

The every time the model is opened in a fresh instance of Vissim it will
open the default layout. The default can be changed by selecting the
option Save Layout as Default.

7 © PTV Group 2017 '



1.1.8 Activity Lesson 1-1

“Working with Vissim”
—E—s—a-——-——-—-—-

Objective:

To become familiar with the network interface. In particular moving and
docking windows as well as saving and loading layout files.

Objects Used:
o  Windows Docking Icons
e File menu
e Layout files (*.layx)
Procedure:
1. Open the file “1-1.inpx”
2. Save as a new file

3. Complete the task within the model

1. Run a Simulation.
a. Press "™ to start a simulation.

b. Press ® to stop a simulation.
2. Open the Network Objects window.
a. Open the View menu.
b. Select Network Objects.
3. Adeust the size of the windows.
a. Hover the cursor over the blue edge.
b. Left-Click and Drag the edge to shift it.
4. Open a new Layout file.
a. Open the File menu.
b. Select Open Layout...
c. Select the file 1-1_Alternate.layx

d. Run a simulation and observe what has changed.

© PTV Group 2017 8



1.2 Background Images

Building an accurate Vissim model from scratch requires at least one
scaled map that shows the real network. The image file of a digitized map
can be displayed, moved and scaled in the Vissim network window and is
used to trace the Vissim links and connectors. Vissim can import several
image formats, both raster and vector, for display. The file formats that
are supported include:

Supported raster formats Supported vector formats
* BMP *DWG

2 JPG * DXF

*PNG * EMF

*TGA * WMF

* TIF (uncompressed & packbits) * SHP (shape files)
* SID (Mr. SID, full res. only)
* ECW (fixed resolution only)

The following steps illustrate how to configure background images:

Loading image file as background image
1. On the Network objects toolbar, click > Background Images.

2 Hold down the CTRL key and in the Network Editor, right-click on the
desired position.

The window Select Bitmap File opens.
3. Select the graphic file which should be imported.
4. Click the Open button.

5. In the Network Editor, click on the icon @ Show entire network on
the toolbar. Then, the digital map is show in its entirety and the name
and a miniature view of the digital map is shown in the background
images toolbar.

Positioning background image
You can position a background image in a Network Editor.
1. On the Network objects toolbar, click > Background Images.

2 In the Network Editor, click on the background image of your choice.
A background image is marked.

9 © PTV Group 2017



3.

Left-click and hold down and drag the background image to the
position of your choice.

Scaling the background image

A loaded background image is not represented according to scale even
when the file has a scale. For the precise modeling of a network, you
must scale the map precisely. Use a large distance, for example > 300
feet. For the adjustment of the background image and the Vissim units,
zoom in on an object or a link with original measurements known to you.
For example, this can be the scale of the map or the edge between two
corners of a building or geo-graphical points. The distance between two
common reference points can often be accurately determined by using the
distance measuring tool in internet based map service.

1.
2:

™~

On the Network objects toolbar, click > Background Images.

In the Network Editor, left-click on the background image of your
choice.

Right-click on the Network Editor.

From the context menu, select the entry Set Scale. The mouse
pointer shows a cross. The reference point is the upper left corner.

Left-click on the desired starting point of the edge and hold and drag
it to the desired end point of the edge.

Release the mouse button to open the Scale window.
Enter the original length of the edge.
Confirm with OK.

The scale of a Vissim network cannot be changed later. Enter the
scale carefully in order to prevent inconsistencies.

© PTV Group 2017- 10



on the background image.

1.21 Activity Lesson 1-2
“Adding Background Images”

Open-the file: \Vissim Intro\Example Files\Ex_2-2_Backgrounad\
NorthAmericaDefault.inpx

This file includes units set to Imperial and a North American vehicle
fleet distribution

Confirm the unit settings by going to Base Data > Network Settings‘
> Units tab. '

Open the background image named Aerial-West.tif by selecting the |
Background Images in the network object toolbar.

Zoom in to the red line on the background image. Right-click and
select Set Scale, then trace the 4,095 feet (1,248 m) red scaling line !

Objects At Chick Potition
Add New Background Image
Zoem To Selection

Delete

Dupticate

Shew In List

Set Scale

Plead Addticnstly Here ]
Sca{e : : -E: 51

Distance: 4095l ft

[ ok ][ canca |

To move the image left-click and hold and drag the image to the
desired location. This may be necessary when tiling multiple images
together.

Once all background images are properly loaded, scaled, and
positioned, lock the background image object in the network objects
toolbar to prevent accidentally moving the images. You will need to ¢
select other than Background Images menu before you can lock the
background images.

&5 Vehicle Travel Times
/=\| Queue Counters

IW £ | Background Images
[ﬂggle selectability in current network editcll

11
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2

Basic Geometry

Network Objects

This chapter is an introduction to building

a basic network in Vissim. Links

Objective Desired Speed Decision

The purpose of this chapter is primarily to =%  Vehicle Inputs
introduce how to create and manipulate %88
the four basic objects in Vissim; Links,

Desired Speed Decisions, Inputs and Routes.

Vehicle Routes

The secondary goal is to demonstrate how to properly construct a freeway
merge area. The model will encompass a multilane segment with both
merging and diverging sections.

We will use default values for many parameters in order to highlight the
mechanics of building the network. Topics such as following or lane
change behaviors, speed distributions and vehicle types or classes will be
covered in greater detail in later chapters. It is important to focus on the
basic mechanics of Vissim in order to build a strong foundation of skill
from which we can apply more complex methods.

2.1 Links
[ ess—————————— .. == e e ]

- Links are the back bone of a Vissim network and
MLUICUCISIl  should be among the first objects created within the

‘ network. Links are used to represent the geometry of
the roadway; curvature, cross-section, etc.

This section will work through these aspects of building a link:
e Creating a link
e Creating a connector
e Adding shape to a link via spline points
e Splitting a link

e Adding lanes to a link

© PTV Group 2017 12



211 Activity Lesson 2-1

“Drawing Links”

Obijective:

To become familiar with the process of creating a link by constructing the
geometry of the roadway. Tasks 1-4 focus on creating and shaping links.
Tasks 5-8 focus on drawing connectors. Tasks 9-13 focus on splitting links
and adding additional lanes.

*IMPORTANT* The keystrokes of creating a link are similar for most
objects and thus complete understanding is vital to successfully
completing other tasks in Vissim. Therefore this activity lesson should be
repeated until we are comfortable with the process before moving on to
Activity 2-2.

By the end of this task you should know the proper keystrokes and
mechanics of constructing/editing links and connectors; how to create new
links, create connectors, split links, and add spline points

Objects Used:

e Links
e LayoutFiles

Procedure:
1. Open Activity Lesson 2-1.inpx.

2. Save as a new file.

Tasks
e Zoom into the “Creating Links” section and complete Tasks 1-4.

e Zoom into the “Creating Connectors” section and complete Tasks 5-8.

e Zoom into the “Adding Lanes and Splitting Links” section and
complete tasks 9-13.

13 © PTV Group 2017



2.:1.2 Activity Lesson 2-2
“Building an On-Ramp”

Objective:

To take the concepts learned in Activity lesson 2-1 and applying them to a
real-world scenario. Task 1 is adding a leg to an existing intersection. Task
2 is creating a merge section on the freeway.

By the end of this activity you should be able to place links and connectors
into your network. You should also know the proper method for creating a
merging section of freeway.

Objects Used:

e Links

Procedure:

1. Open Activity Lesson 2-1.inpx.

2. Save as a new file.

Task 1: Adding a leg to the intersection
1. Draw an on-ramp link from position b to f.
2. Create the SB left turn movement:
a. Add a lane to the left of the SB link at position a.
b. Draw a connector from position a to b.
3. Create the EB through movement:
a. Draw a connector from positibn etob.
4. Create the NB right movement:
a. Split the NB link at position d.
b. Add a lane to the right of the NB link at position d.

c. Draw a connector from position d to c.

(Task 2 on next page)

© PTV Group 2017 14



Task 2: Adding a freeway merging area
1. Split the freeway link at points f and g.
2. Add a lane to the right on the freeway section between f and g.

3. Draw a connector from the ramp to the new lane at position f.

F: Start of the weaving lane/merge point

F *

G: Lane drop/end of the taper

15 © PTV Group 2017



2.2 Desired Speed Decisions

__—_-_|---———----- - -0 =

. Desired Speed in Vissim is the speed at

Network Objects | which the vehicles wish to travel. If there

(50}l Desired Speed Decisions are no obstacles ahead a vehicle will
: - proceed at its assigned desired speed.

Vehicles are generated with a pre-determined
Desired Speed (please see the next section
on vehicle inputs for further information).
Desired speed decisions permanently change
the driver’s desired speed.

Conceptually they act like posted speed limit
signs. When a vehicle passes a desired
speed decision their desired speed changes
to whatever was posted on the desired speed
decision point.

However each vehicle is not assigned the '
same desired speed. Individual vehicles are assigned a speed within a
speed distribution. A distribution of speeds is used to ensure not every
vehicle is traveling at exactly the same rate.

Using a distribution helps randomize the vehicle population, form platoons,
and encourage realistic behaviors such as passing. If a vehicle is traveling
below its desired speed it will make attempts to accelerate until it reaches
its desired speed again. If there is a slower vehicle ahead it will look for an
opportunity to pass.

© PTV Group 2017 16



2.21 Demo 2-3
“School Zone”

In this demo we see vehicles driving from left to right. Initially their speed

will be distributed around 30 mph. They will drive into a school zone where |
the posted speed limit is 20 mph. The vehicles will begin decelerating after

they cross the Desired Speed Decision. Once they have traversed the

school zone they cross another desired speed decision causing them to

return to their original speed of 30 mph.

Procedure:
1. Open “Demo 2-3.inpx"
2. Press the blue play button to start the simulation.
3. Observe when the vehicles’ desired speeds and actual speed
«  Wait for a vehicle to enter the network
«  Pause the simulation using the spacebar
« Select a vehicle in the network

« In the Quick View window observe the values for
“Speed” and “DesSpeed”

4. Advance the simulation slowly by holding the spacebar down.

Observe what happens when the vehicle crosses the desired
speed decision.

474 © PTV Group 2017



2.2.2 Creating Desired Speed Decisions

Left-click to select the Desired @

Speed Decisions object. Desired Speed Decisions

Left-click to select the link or connector on which the desired speed
decision will be placed.

Create the desired speed decision by holding the Ctrl key and right-
clicking at the location where the vehicles are expected to begin
accelerating or decelerating to the new desired speed.

The desired speed can now be assigned by vehicle class in the dialog
ort in the desired speed decision list.

*NOTE* the dialog can be opened by double left-clicking on a
selected desired speed decision.

Right-click to add a vehicle class and define the appropriate speed.
Click Ok to save the settings.

% Desired Speed Decision )

e o - ]

EI No.: 1 Name; ‘
Link: 10 Time From: - AB 5
Lane: ‘ N ) 7] until O 99995 5

At: 1499.032 ft Label

Count: 2| VehClass { DesSpeedDistr
|65: 65 mph (freeway)

~ |s5:55mphfreeway) [+

© PTV Group 2017 18



2.2.3 Activity Lesson 2-4
“Speed Control”

Objective:

To become familiar with placing and configuring a network’s speed
settings through the use of Desired Speed Decisions. In this example
desired speed decisions are used both as the posted speed limits as well
as the suggested on/off-ramp speeds.

By the end of this activity you should be able to create a desired speed
decision as well as know where they should be placed.

Objects Used:

o Desired Speed Decisions

e LayoutFiles

Procedure:

1. Open the file “2-4.inpx.”

2. Save as a new file

3. Complete the tasks below.

Task:

1. Open the layout file “Theoretical Speed.layx”.
This will color vehicles based on their assigned Desired Speeds.

2 Run a simulation and observe the colors of vehicles that travel from
the freeway onto the arterial.
After Discussion stop the simulation.
Place Desired Speed Decisions where the posted speed changes in
the network. Set the distributions so they match the posted speed for
both cars and HGV (trucks).

5. Open the layout file “Actual Speed.layx”
This will color vehicles based on their current actual speed.

6. Run a simulation and observe when vehicles are accelerating/
decelerating in relation to the desired speed decisions.

19 © PTV Group 2017



2.2.4 Creating a Basic Speed Distribution

In this section we will learn how to create a basic 85th percentile
speed distribution in Vissim. In chapter 8 we will discuss creating a
seed profile in greater detail.

To create a basic speed distribution, follow these steps:

1. Open the Base Data Menu
. Hover over Distributions to expand the menu
3. Select Desired Speed. This will open the Desired Speed
Distributions list.

4. Press the * button to create a new distribution.

Define the minimum and maximum speeds.

6. Add intermediate points to define percentiles.

a. Right-Click on the graph to add a point.

b. Left-Click and drag the point to the appropriate posntlon.

o

A) Define an ID number for this distribution. It is common to give the ID
number the value of the target speed of the distribution.

B) Naming the distribution will help identify it later.

C) Define a minimum value for the distribution.

D) Define a
maximum value
for the
distribution. » i D 9 e

E) The intermediate C -
points represent S ,
percentile /e -
speeds. :

F) The vertical axis "
represents the Vs
percentile
(1.0=100%) rd

G) The horizontal /
axis represents
the speed. o

Mo B A e BB B

-
“,

Lox  J[ camn |
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2.2.5 Activity Lesson 2-5
“Creating a Simple 35 mph Speed Distribution”

Objective:

By the end of this activity you will know how to create a basic speed
distribution using the distribution editor as well as creating 85th percentile
speeds.

Objects Used:
e Base Data Menu
e Desired Speed Distribution List
o Desired Speed Distribution Editor
Procedure:
1. Open the file “2-5.inpx”.
2. Save as a new file

3. Complete the task below.

Task:
Create a new basic 35 mph speed distribution

1 Open the Desired Speed Distribution list.
a. Open the Base Data menu.
b. Select Distributions -> Desired Speed.

2 Open the existing 35 mph speed distribution and discuss how the
speeds are distributed.

3 Create a new 35 mph speed distribution.
a. Press the “+” to add a new distribution.
b. Name the new distribution “35 mph = 85%"
4 Add an intermediate point to the curve.
Set the point to 35 mph and 0.85.

6 Apply the new distribution to the existing arterial speed decisions.

21 © PTV Group 2017



2.2.6 Activity Lesson 2-6

“Lists”
EBEBEeEeEemm—————s-—s—| - - ——————

Objective:
To be introduced to working with a list to edit parameters. We will apply a

different speed distribution to HGV traffic using the Desired Speed
Decision List.

Objects Used:

. Desired Speed Decision

. Desired Speed Decision List
. Synchronization buttons
Procedure:

Open the file “2-6.inpx”.
Save as a new file

Complete the task below.

Task:
1 Open the Desired Speed Decisions list.

a. Right-Click on the Network Object title.
b. Select the “Show List” option.

2 Activate synchronization between the list and the network editor view.
Whenever an object is selected in the list, Vissim will center the
network editor view on that object.

~
a. Select the button z in the list. It will change to gwhen
active.

b. Select the button & in the network editor. It will change to

'E'H when active.
3 Change the freeway speed for HGV'’s (trucks) to 55 mph.

a. Inthe column “DesSpeedDistr(20)” change the speed to 55
mph for decisions 1 and 7.

4 Run a simulation and observe truck speeds in the quick view window.
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2.3 Vehicle Inputs

Traffic volumes entered a specific link at a
stochastic rate. The volumes are always
input as vehicles per hour even if the input
time period is longer or shorter than one
hour. Within this time vehicles enter the link
based on a Poisson distribution. If the defined traffic volume exceeds the |
link capacity, the vehicles are ‘stacked’ outside the network until space is
available again. If any ‘stacked’ vehicles cannot enter the network within
that simulation a message is written to a log file and we are notified at the
end of the simulation.

Network Objects

Vehicle Inputs _

We can define time variable traffic volumes by creating custom time
intervals for vehicle inputs. This process however will be described in
greater detail in a later chapter.

234 Creating Vehicle Input Points
1. Left-click to select the Vehicle Inputs Object. et inois]
Iclie i

2. Left-click to select the link where a vehicle Ef' 3 C APU,A '
input should be defined.

3. To add a new vehicle input, hold the Ctrl key and right-click. A new
vehicle input will display in the vehicle input list.

4. Open the Vehicle Inputs list. Right-click on the Vehicle Inputs
Network Object and select “Show List".

5. Define the input volume (always in vehicles per hour) in the

“Volume(0)” column.
6. Define the vehicle composition

in the “VehComp(0)” column.

Vehicle Inputs / Vehicle Volumes By Time Interval

Select layout... « FI 0 L |2 B @ Vehiclevolumes by tir ~ RHEAR ®
Count: 4| No | Name | Link Volume(0) | VehComp(0) ] |
1| 1] [uleses | 3538 Lifreeway (8% HGY) I {
2 2| [3:FainviewParkwaySB | 3884:urban (5% HGY) |
3| 3| |:le4WB_ | 2764|1: freeway (8% HGV) _ |
4 4 |4: Fairview Parkway NB|  956|4:urban (5% HGY) | !

*NOTE* The “(0)” means this volume/composition will begin to apply
at simulation second 0.
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2.3.2 Activity Lesson 2-7

“Adding Vehicular Inputs”
e . = e ——— — —— = > e

Objective:
To place and configure Vehicle Inputs on the edges of the network.

Objects Used:
e Vehicle Inputs

e Vehicle Inputs List

Procedure:

1. Open the file “2-6.inpx”.
2. Save as a new file

3. Complete the task below.

Task:
1 Add the SB vehicle input to link #3.

a. Volume: 388

b. Composition: Urban (2% HGV)
2 Add the NB vehicle input to link #4.

a. Volume: 956

b. Composition: Urban (2% HGV)
3 Add the EB vehicle input to link #1

a. Volume: 3538

b. Composition: Freeway (8% HGV)
4 Add the WB vehicle input to link # 2

a. Volume: 2764

b. Composition: Freeway (8% HGV)
5 Run a simulation and observe the arrival patterns of each input.
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24 Static Routing

= Static routes provide fixed paths and fixed
Network Objects volumes along those paths despite some
Vehicle Routes potentially undesirable conditions. The
static vehicle routing decisions in Vissim
can be used for modeling intersection
turning volumes or as O-D paths depending on what data the modeler has
at their disposal.

Vissim uses a few different methods to route vehicles through the network;
the two most common methods are Static Routes and Dynamic Routes.
Dynamic routes may change the paths a vehicle will travel along during a
simulation based on levels of congestion, the financial cost of a particular
route, etc.

Please note that the Vissim Introduction course exclusively uses static
routing methods.

Static routes use a concept called Relative Flow to determine the
proportion of vehicles that use each path.

Relative flow of A

Probabilit taki thA =
robability of taking pa ¥ Relative Flow of all paths

It is because of this property that Static routes can be used whether we
have turn counts or percentages and hourly or daily counts are
automatically scaled to fit within the simulation window.

241 Creating Static Routes

1. Left-click to select the link/connector for E Vehicle Routes (Static) E

the start of the route.  Statio- ey . 4 e s |

. Partial |

2. On the Routing Decision object drop- |1 okl B ;
down menu select the desired routing [\ Dymamc |
decision type (static). "Closure |
Managed Lanes i

3. Hold the Ctrl key and right-click on the
location for the routing decision point on the selected link. A pink bar
will show for the routing decision placement.

4. Left-click on the link/connector for the route destination. The end of
the route is shown with a light blue bar and the route from the decision
bar to the destination bar will highlight yellow along the links and
connectors that make up the shortest path.
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5. Vissim will be ready to add another route for the current routing
decision. Select a different link to place another destination

6. Repeat for all destinations.

Click off of the network in grey space (“X" cursor will display) to end
adding routes to the active routing decision.

8. Once all routing decisions and routes are defined open the vehicle
routing decision list.

9. Set the coupled list to Static Vehicle Routes by selecting it from the
drop-down menu in the static routes list

Static Vehicle Routing Decisions / Static Vehicle Routes i x
Sefect layout.. & XS i @ suticvehicleroues i RO B XL 2B
Count 4 No  Link Pos <Single List> Count: 3 VehRoutDee | No  Destlink DestPos | Retflon(d)
1 Link bl
1 1Ll84Ee 141 Static vehicle routes 11 1 1%: Faisviaw Parkway 651 334
2 24:Fainview Packway 231 Vehicle dlasses 21 29:1-8418 940 2555
3 32:184W3 158 T 31 3 18: Fanoew Parkway 161 649
4 43 Fainview Padenay 104
Static Routing Decisions List Static Routes List
(destinations)

10. Select the desired route and enter the relative flow for each
movement.
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2.4.2 Activity Lesson 2-8
“Adding Static Routing Decisions”

Objective:

To draw static routes from origin to destination and configure the turning
volume in a scenario where vehicles only make one routing decision in the
network.

Objects Used:
e Static Vehicle Routes
e Static Vehicle Routes List
Procedure:
1. Open the file “2-8.inpx"
2. Save as a new file

3. Complete the task below.

Task:
1. Create a decision point at position A.
a. Place destinations at positions F, G, and H.
b. Assign relative flows F=22, G=84, H=282.
2. Create a decision point at position B.
a. Place destinations at positions G, H, and E.
b. Assign relative flows G=108, H=2656, E=54.
3. Create a decision point at position C.
a. Place destinations at positions H, E, and F.
b. Assign relative flows H=547, E=956, F=66.
4. Create a decision point at position D.
a. Place destinations at positions E, F, and G.
b. Assign relative flows E=334, F=2555, G=649.
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3

Intersection Control

This chapter is an introduction to junction
modeling; two-way stop, actuated signals
and fixed-time signals.

Objective:

The purpose of this chapter is primarily to
introduce how to create and manipulate
conflict avoidance objects in Vissim;
Reduced Speed Areas, Conflict Areas,
Priority Rules, Stop Signs, Signals and
Detectors through the lens of building an
arterial segment.

Network Objects

Links
Desired Speed Decision
Reduced Speed Areas
Conflict Areas

Priority Rules

Stop Signs

Signal Heads

Detectors

Vehicle Inputs

Vehicle Routes

The model will encompass a two-way stop and a signalized intersection.
The model will use default values for many parameters in order to highlight
the mechanics of building the network. Topics such as following or lane
change behaviors, speed distributions and vehicle types or classes will be

covered in greater detail in other chapters.

3.1 Review Chapter 2

While we have already looked at Links,
Desired Speed Decisions, Vehicle Inputs
and Static Routes it is important to see
and use these object within a different
context.

Network Objects

Links

Desired Speed Decision

Vehicle Inputs
Vehicle Routes

© PTV Group 2017
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314 Activity Lesson 3-1
“Geometry and Demand on Arterials”

Objective:

To practice building the basic geometry of an intersection; Left turn bays,
right turn connectors, routes, and desired speed decisions.

Objects Used:
e Links
e Desired Speed Decisions
e Static Routes
Procedure:
1. Open the file “3-1.inpx”
2. Save as a new file
3. Complete the task within the model.

Task:
1. Zoom in to the intersection at 102nd Ave. and Glisan St.
2. Draw left turn bay connectors:
a. SBfromAtoF.
b. WB from B to G.
c. NB from C to H.
d. EBfromDtoE.
3. Draw right turn connectors:

a. SBtoH.
b. WBtoE.
c. NBtoF.

d. EBtoG. m
Switch to Wireframe mode (Ctri+A)
Place Desired Speed Decisions the outbound legs, just downstream of
all connectors.
a. Assign 25 mph distributions at E and G.
b. Assign 35 mph distributions at F and H.
6. Vehicle inputs have already been placed.
7. Create a static route for each approach:
a. Place the decision points at A, B, C, and D.
b. Create left, thru, and right-turn routes.
c. Assign relative flows on all approaches as follows:

C7) oo

i. Left=35%
i. Thru=50%
ii. Right=15%

8. Run a simulation and observe the behavior of the vehicles.
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3.2 Reduced Speed Areas
=—b° — ——— —— — - ——~—_— —— ——— ————~ |

Reduced Speed Areas serve as temporary speed reduction zones. They
should be placed where it is expected that a vehicle slowdown in
anticipation of some maneuver ahead be-it a sharp curve, a turn or even a
crosswalk where drivers are cautious enough to apply the brake.

It is important to remember that Vissim vehicles have no internal
knowledge of “sharp curves” or turns. Therefore they will not slow down
based on the geometry of the link. It is at places like this where the
primary use of Reduced Speed Areas occurs.

Common places to use Reduced Speed Areas include:
e Right turn connectors
e Left turn connectors
e Sharp curves

e In road delineation locations where it is expected for drivers to
slow (roundabout approaches).

Reduce speed areas assign a new desired speed to the vehicles that
enter the space and then automatically change it back when they leave
the space.

Reduced speed areas also cause the vehicle to decelerate PRIOR to
reaching the start of the reduced speed area. This is designed so that
vehicles are at their new desired speed by the time they enter the space.

3.2.1 Example 3-2
“Speed Bump-Temporary Speed Reduction”

This example demonstrates how a reduce speed area causes a vehicle to
slow down and then recover after traversing the space.

Open the file “3-2.inpx”

Run the Simulation

Pause the simulation when a vehicle appears on the link.

Select the vehicle and observe the vehicle’s actual and desired speed.

Slowly advance the simulation by holding the spacebar.

O o s W N s

Observe the vehicle’s actual and desired speed as it traverses the
reduced speed area.
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7.

3.2.2 Creating a Reduced Speed Area

Left-Click to select the “Reduced Speed Areas” object.

Left-Click to select the link or connector where the reduced speed
area should be placed on. A reduced speed area cannot span
over more than one link/connector.

Hold Ctrl and rightclick at its start position (inside the
link/connector) and drag the mouse along the link/connector while
the right button is held down.

Release the mouse button when at the appropriate length.

The desired speed distribution can now be assigned by vehicle
class in the reduced speed area list, or in the reduced speed area !
dialog opened by double left clicking on a selected reduced speed
area.

Right-click to add a vehicle class and define the appropriate speed
distribution and deceleration value.

Confirm with Ok.

For multi-lane links reduced speed areas need to be defined for each lane
separately. Thus different characteristics can be defined for each lane.

31
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3.23 Activity Lesson 3-3
“Placing Reduced Speed Areas”

Objective:

To practice creating reduced speed areas at one of the most common
locations within a Vissim network; an urban intersection.

Objects Used:
e Reduced Speed Areas

Procedure:

1. Open the file “3-3.inpx”

2. Save as a new file

3. Complete the task below.

Task:

1 Zoom into the intersection at 102nd Ave. & Glisan St.

2 Create 10 mph Reduced Speed Areas on the right-turn connectors;
a. Place them at the apex of the curve
b. Make them about 10 ft. long

3 Create 15 mph Reduced Speed Areas on the left turn connectors:

a. Place them at the apex of the curve after downstream of the
left-turn bay

b. Make them about 10 ft. long

4 Press Play on the simulation and observe the vehicle behavior.
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3.3 Conflicting Movements

Within Vissim, vehicles that are on the same link follow one another, work
to make lane changes or even pass each other. However vehicles
traveling on different links do not interact in the same way. In fact, vehicles
on different links do not interact at all unless they are told who has the
right-of-way.

In traffic there are generally three types of conflicts; merging, diverging
and crossing. Vissim has two different objects for controlling these
hazardous zones, conflict areas and priority rules.

The two object do no, and in the vast majority of cases, should not be
used at the same time. It is up to the modeler to decide which object is
most appropriate.

334 Conflict Areas

Conflict areas are automatically generated any time two or more links
occupy the same space. A conflict area has four states;

1. Passive (displayed yellow-yellow)

2. 1 waits for 2 (link 1 is displayed red and link 2 is displayed green)
3. 2 waits for 1 (link 2 is displayed red and link 1 is displayed green)
4

Undetermined (both links are displayed red and it is first-come-
first-served)

As vehicles on the minor street (displayed as red by the conflict area)
approach the conflict area they determine whether there is a sufficient gap
for them to pass through the conflict without disturbing the major
movement traffic. If need be a vehicle will change speed or come to a
complete stop to avoid a “crash”.

Vehicles on the minor street will attempt to minimize their delay so if they
do not need to stop they will merely slow their approach to time a crossing
just right.

Conflict areas use a few parameters to calculate acceptable gap including
“front gap” “rear gap” and “safety distance factor’ however these will be
discussed in more detail in chapter 8.
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3.3.2 Demo 3-4

“Conflict Area States”
e a0 . -—_——————_ .0

In this example we see what the four conflict area types do to intersecting
traffic.

1. Run the simulation

2. Observe vehicle behavior

3.3.3 Configuring a Conflict Area
EBeee—-— = . - - ————

As previously stated, all overlapping sections of links will create a conflict
area automatically. Therefore all that is needed is to determine where
conflicts actually exist and which movements have the right-of-way. For
example an overpass or flyover link might produce conflicts that aren’t
supposed to exist; therefore they are left as passive.

1. Select the Conflict Areas network object
2. Right-click on a conflict area in the network editor
3. From the context menu choose one of these options;
a. Passive
b. 1 waits for 2
c. 2 waits for 1
d. Undetermined
OR
2. Hold Ctrl
3. Right click on a conflict area to cycle through the different states
Remember:
e Green = main flow (right of way)
e Red = minor flow (yield)

o Both Red = first-come-first-served (if two vehicles arrive at the
exact same time the vehicle to the right, counter clockwise, should
go first.

e Both Yellow = Ignore each other
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3.3.4 Activity Lesson 3-5
“Configuring Conflict Areas in the Network”

Objective:
To code conflict areas in a way that gives appropriate yielding behavior.
Objects Used:
e Conflict Areas
Procedure:
1. Open the file “3-5.inpx”
2. Save as a new file.

3. Complete the task below.

Task:
1 Configure the right turning movements to yield to the target lane
traffic.

a. Left-Click to select a conflict area

(If multiple are stacked on top of each other left-click on one
then press Tab to cycle through conflict areas).

b. Hold Ctrl.

c. Right-Click on the conflict area to cycle through the states until
the through is green and the right turn is red.

2 Configure left turning traffic to yield to oncoming traffic.
a. Left-Click to select a conflict area

(If multiple are stacked on top of each other left-click on one
then press Tab to cycle through conflict areas).

b. Hold Citrl.

c. Right-Click on the conflict area to cycle through the states until
the oncoming movement is green and the left turn is red.

3 Run a simulation and confirm proper yielding behavior.
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3.3.5 Priority Rules

The other object that controls yielding
behavior is the Priority Rule. Unlike the
conflict area the priority rule is not
automatically generated when links
overlap. Furthermore priority rules are
much more flexible about where they are
placed and how they are used. Internally
their concept of “gap” differs from a
conflict area as well.

The drawback to priority rules is that they
take longer to code and conflicts can be
easily overlooked or forgotten.

A priority rule consists of one stop line
(orange bar) and one or more conflict
markers (green bars) that are associated
with a specific stop line. Depending on
the current conditions at the conflict
marker(s), the stop line allows vehicles to
cross or forces them to stop. The two main
conditions to check at the conflict
marker(s) are;

Minimum Gap Time (sec) for free flow
traffic on the main road or,

Minimum Headway (ft/m) for slow
moving or queuing traffic on the main road.

If the current gap time is less than the
minimum gap time or if the current
headway is less than the minimum
headway, any vehicle approaching the
stop bar will stop at the stop line.

conflict marker
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Current Gap Time (sec)

Determined by the
amount of time a major
movement vehicle will
require to reach the
conflict marker (green
bar) from its current
position assuming that it
continues traveling at its
current speed. A vehicle
located on the green bar
is not considered by the
current gap time.

Current Headway (feet/meters)

Determined by the physical distance between the conflict
marker (green bar) and the front bumper of the first major
movement vehicle approaching it. If any part of a vehicle is
located on the green bar the resulting headway is Oft.
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9.

3.3.6 Placing and Configuring Priority Rules

Select the Priority Rule network object.

Left-Click to select the link/connector on which the stop line (yield
point) should be placed.

Hold Ctrl
Right-click at the location of the stop line (yield point).

Left-Click to select the link/connector on which the conflict marker
should be placed.

Right-click at the location of the conflict marker (green bar).
Typically it is located within the last two meters of the area of
conflict.

The priority rule parameters can now be defined in the dialog.
Repeat steps 6 and 7 for subsequent conflict markers

Left-click off of the network to complete the task.

The cqntext menu can be used to add additional conflict markers to an
existing priority rule.

37
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3.3.7 Activity Lesson 3-6

“Creating Priority Rules”
e s )

Objective:

To become familiar with placing priority rules as well as determining where
priority rules should be placed.

Objects Used:
e Priority Rules
Procedure:
1. Open the file “3-6.inpx”
2. Save as a new file
3. Complete the task below.
Task:
At each of the eight sample movements place the necessary priority rules:

1 Place the yielding movement’s stop bar at the red arrow labeled “1”
and “2" (some movements require the yielding vehicle to stop more
than once).

a. Hold Ctrl
b. Right-Click at the yield point to place a stop bar.

2 Place the priority movement's conflict markers at the green arrows
labeled “a@” and "b” (some conflicts require more than one conflict
marker).

a. Right-Click at the downstream position where the conflict
ends.

b. Configure the Min Gap to be 3.0 sec

c. Configure the min headway to be as wide as the conflicting
lane ~12ft

3 When all conflict markers are placed and configured. Left-Click off the
network twice to complete the priority rule.
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3.4 Stop Signs

#

In Vissim a stop sign is a bar placed in the lane at _
which a vehicle will be forced to decelerate to 0 | Rolling Stops

mph for at least one time-step. Some studies on
. . . . . stop controlled

Stop signs must be used in conjunction with either intersections
a priority rule or a conflict area to assign proper | report high flow
yielding behavior and gap acceptance. rates due to
“rolling stops”. A
3.4.1 Placing a Stop Sign reduced speed
1. Select the stop sign network object. desired  speed

s . , . distribution may
2 Left-Click to select the link on which vehicles be used to

will have to stop. model a rolling
3. Rightclick on the link at the location where | Stop, instead of
vehicles should stop. a stop sign.

3.4.2 Activity Lesson 3-7
“Two-Way Stop”
Objective:

To become familiar with placing a stop sign in a Vissim network as well as
where it should be placed within the lane.

Objects Used:
e Stop Sign
Procedure:
1. Open the file "3-7.inpx”
2. Save as a new file
3. Complete the task below.
Task:
1 Place stop signs on the minor street approaches at 104" and Glisan.

2 Run a simulation and observe where vehicles stop and where they
wait for gaps.
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3.5 Signalized Intersections
e

In the field we observe three primary components at most signalized
intersections; some form of detection, some machine or computer

controlling logic and signal display objects.

Within Vissim these three components are modeled
quite similarly to in the field. Vissim uses detectors
to collect necessary data, signal controllers to
process the data into signal timing and signal heads
to relay the signal timing to vehicles.

3.5.1 Ring-Barrier Controllers
=———=—=——Sar <. " = =——=———— ——————a—a}

Signal controllers in North America vary from city to
city and even intersection to intersection depending
on the needs and requirements in each situation.
While Vissim does not provide an exact interface to
every brand of signal controller, it does offer a
variety of types of controllers.

The primary controller used by the majority of
agencies is the Ring-Barrier controller (RBC).
Therefore this will be the controller used in this
course.

The RBC interface provides users with a seamless
way of modeling complex real-world traffic signal
timing such as actuated control, railroad
preemption, and transit signal priority. During a
simulation, Vissim passes the status of detectors
and signal heads to the ring barrier controller and
the controller returns the state of the signal heads
for the next time step.

3.5.2 Generating RBC’s
Bee——a-—a————-—=—aaa——ux—-——_—u )

Vissim offers the ability to code a signal controller
from scratch. However this task demands
substantial amounts of time and a deeper look into
signal controller operation. Therefore PTV offers
and advanced Vissim course in signal timing and
operations.

Signal Controller
Types:

Ring Barrier
Controller
-Primary controller
type in North
America ’
-Fixed time control
mode

-Actuated control
mode

-Time of Day
patterns
-Coordinated
timing

-Free Running
Operation

-Transit Signal
Priority
-Preemption

Fixed Time
Controller
-European Stage
Based Controller

type

Software-In-the-
Loop Controllers
-ASC/3

-McCain 2033
-SCATS

-SCOOT

Script-Based
Controllers
-User Defined
Logic

-VAP

© PTV Group 2017
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If you are interested in dates and prices of the
“issim-Advance RBC” course please speak | Ring-Barrier Controllers
with your instructor or contact PTV Group at generate *.rbe file
info.us@ptvgroup.com. extensions.

In many cases a Vissim modeler already has access to signal timing within
other software. Controller logic files can be created, calibrated and
coordinated in planning level programs like PTV Visum or HCM/ICA
programs like PTV Vistro with ease. Therefore importing signal logic
becomes a major time-saver.

Furthermore, already existing Vissim controllers can be copied from other
files further saving the modeler time and energy.

*NOTE** It is recommended that controllers created in Vissim are also saved
to a company-wide library so they can be applied and adapted to other models.

Once we have generated or selected from a library the appropriate
controller logic, we will connect it to Vissim in the following way:

1. Open the Signal Control menu

2. Select the Signal Controllers option to open the signal controllers list

3. Press the green add button, | to create a new controller

4. A signal controller dialog will open
a. Enter the controller number

b. Enter the controller name (usually the two street names such
as “1°' Ave. and Main St.)

c. Select the RBC controller type
5. Press the Edit Signal Groups button
6. The RBC interface will open
7. Open the File menu
8. Select Import
9. Select the appropriate *.rbc file
10. Press Open
11. The logic will import, check for correct timing and configuration.
12. Click OK to save the logic

13. In the Signal Controller dialog click OK to save the controller.
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Once the controller is saved it can be referenced by other Vissim objects
like signal head, detectors and evaluations.

3.5.3 Activity Lesson 3-8

“Adding a phase to a Ring-Barrier Controller”
==, — " ——— .~ - ——— > _--————1

Objective:

In this activity we will see how to import a RBC file as well as how to
create signal phases.

Objects Used:

° Ring-Barrier Signal Controllers
o *.rbc files
° Signal Groups

Procedure:

1. Open the file “3-8.inpx”
2. Save as a new file

3. Complete the task below:

Task:
Create a Signal Controller
1. Open the Signal Control menu.

2. Select Signal Controllers to open the signal controllers list.

3. Press the “*” button to create a new signal controller.
4. Select the RBC controller type.
Press the “Edit Signal Groups” button to open the RBC editor.
a. Open the File menu in the RBC Editor
b. Select Import
c. Open the file "3-8.rbc”
d. View the signal timing
e

Click Ok to save the controller.
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Create a New Phase.

1. Open the RBC editor.

2. Open the Basic View
a. Open the View menu
b. Select Basic View

3. Add the following phase information for phase 1 and change the
timing for phase 2:

Basic

SG Number 1 2 Phase Number

Min Green 5s 10s  Minimum Green Duration

Veh Extension 3s 3s Green Extension/Gap Out Condition
Max 1 20s 40s Maximum Green Duration

Yellow 4s 4s Yellow Clearance

Red Os 1s  All-Red Duration

Max Recall v vV Times Max Green Every Cycle
~NOTE** Activating Max Recall on all phases sets the controller to fixed time.
Pattern 1

Splits 24s  45s Max 1 + Yellow + Red

Seguence

Ring 1 1 2 3 4

Ring 2 5 6 7 8
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3.5.4 Signal Heads

Signal heads, like stop signs are placed in a particular lane and force a
vehicle to decelerate to 0 mph. However unlike a stop sign a signal head,
while showing red, will not allow vehicles to cross. Once the signal head
shows green vehicles may accelerate back to their desired speed.

3.5.5 Placing Signal Heads

Select the Signal Heads network object.

2. Left-Click to select the [#sgniiad TNNNNNGG_G_G

link on which vehicles

No.: 1
will have to stop. 1 Link: 10036 Vehicle Classes
3. Right-Click on the link Lane 1 .
at the location where - :[&5 3
vehicles should stop. il
4b/7¢  signal group: [T__,—____Ll_
4. Configure the signal Type: (Crewsr  +]
head; Th ———————— [7] Orsignal group
sC
a. Select the 7€ —> signalgroup: |
Slgnal ContrO“er Rate of compliance:  100.00 3%
number [7] Discharge record active
b. Selectthe [7] Block signal
Signal group Amber speed: 0.00| mph
[V] Labet
5. For protected left — S
turns code the Signal [ ox ] [ concd ]
group as the left turn

phase

6. For permissive left turns select the though phase for the signal
group

7. For protected-permissive left turns;
a. Code the Signal group as the left turn phase
b. Check the “or signal group” box
c. Select the associated through phase for the signal group.

8. Click OK to save settings
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3.5.6 Activity lesson 3-9
“Placing Signal Heads”

Objective:

To become familiar with
placing signal heads and 8 3

connecting them to
signal controllers 1 L
Protected

Objects Used:

. Signal 1
Heads Protected-Permissive 1
6 -— 2
Procedure:

Protected-Permissive 5

1. Open the file "3- | 27

9.inpx”
Protected
2. Save as anew file <—| I I—o
3.

Complete the task

below. 7 4
Task:
1. Add Signal Heads to each lane of the intersection at 102" and Glisan.
Hold Ctrl

Right-Click at the desire stop position in the lane
2. Configure the signal head
Select the Signal Controller
Select the Signal Group
o For protected left turn lanes:
o SG: Select the left turn phase number.
o Or Sig Group: leave UNCHECKED
o For permissive left turns:
o SG: Select the opposing through phase number.
o OR Sig Group: leave UNCHECKED
e For protected-permissive left turns:
o SG: Select the exclusive left turn phase number
o OR Sig Group: Select the opposing through phase
number
e Foroverlap right turns:
o SG: Select the overlap phase number
3. Configure the phases according to the diagram above.
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3.5.7 Detectors

Vissim detectors work much the same way as detectors work in the field.
As soon as the front of a vehicle crosses the detector a detection signal is
sent to the controller. As soon as the rear of that vehicle leaves the
detector the signal changes to no detection. This information is then
interpreted by the signal control logic to determine what to do next.

Detection in the field is achieved using various methodologies including
induction loops, video cameras, push buttons, track circuits, etc. Vissim
models each detector type in the same way; wherever the calibrated
detection zone is, is where a detector should be placed:

. Induction loops-place the detector in the same location on the
link
. Video cameras-place the detector on the link within the same

zone a camera will read a vehicle as detected

. Push button- place a detector on the ground where a
pedestrian would stand to press the button

To define a new detector on a link follow the steps outlined below:
1. Select the Detectors network object.
2. Left-Click to select the link the detector will be placed on.

3. Right-Click on the location within the link where the detector should
start (upstream location).

4. In the context menu | I petector
select Add new detector. U e
The new detector will be e e
created with a default tengtt sk 3
length of 9.84 feet (3m). Type: [Standard___+]
5. Double Left-Click on the Location | Activation [ Other |
detector to open the Link: 6 At 384731 g
detector editor window Livie: [T | Betarestops. | 135M) f

6. Define the port number
to be the phase number
this detector calls

7. Assign the appropriate
controller number ok | [ Concel

8. Click OK to save settings
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3.5.8 Activity Lesson 3-10
“Adding Controller Detection”

Objective:

To become familiar with placing detectors in the proper locations as well
as assigning them to the appropriate signal phase

Objects Used:

. Detectors
Procedure:
1. Open the file “3-10.inpx"
2. Save as a new file
3. Complete the task below.

Task:

Add detection to the controller.
1. Open the RBC editor
2. Open the Basic View, View—Basic View.
3. In the basic menu uncheck “Max Recall” for all phases.
4. In the detector section configure the detector ports.

Detector Number 1 2 3 4 6 6 T 8
Call 1 2 3 4 5 6 7 8
Extend SGs 1 2 3 4 5 6 7 8

|
**NOTE** It is good practice to assign the phase number as the detector number
This will help avoid confusion in later steps.

5. Click Ok to save settings.

Add detectors to the network.
1. Draw the detectors in lane.
a. Hold Ctrl
b. Right-Click and Drag the cursor to draw a detector
2. Configure the detector.
Port No.: Set the port number equal to the RBC Detector
number.
SC: Assign the associated signal controller
Type: Standard
Length: Usually between 10 and 20ft
Before Stop: distance
upstream of the signal
head
3. Run a simulation and observe the signal operation.

Example: A stop bar detector's
“Before Stop” = “Length” + 2ft
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3.5.9 Right Turn On Red (RTOR)

When a vehicle is allowed to make a right turn during a red light, the driver
is supposed to treat the signal as they would a stop sign; come to a
complete stop, then check for conflicting traffic.

In Vissim an approach is configured for RTOR using a stop sign. Stop
signs can be configured to work in conjunction with a specific signal group.

, m Stop Sign

l Location Time Distribution

Only on Red:
sc: (3 v|
SigGrp: [4 v]

By setting that stop sign as shown above, vehicles will stop at the stop
sign when the parent signal group is displaying red, otherwise they will
ignore the stop sign all together.

3.5.9.1 Exclusive Right with RTOR

For an exclusive right turn lane the stop sign may be used instead of a
signal head. For example, if the EB right turn is controlled by overlap
phase 9. Code the overlap phase into the controller and then place a stop
sign in the lane configured to reference signal group 9.

*NOTE** Many users still prefer to see a signal head in the lane. In this case
we can code a signal head referenced to phase 9 but deselect all vehicle
classes. This will make it so that all vehicles ignore the signal head. Then place
a stop sign at the same position configured for RTOR and referencing phase 9.
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3.5.9.2

Shared Through-Right with RTOT

For a shared through-right lane the placement of connectors, signal
heads, and stop signs becomes very important.

Through Movement

The through moving traffic must still pay attention to the signal head so we
can leave it at the desired stopping point on the through link.

Right Turning Movement

The right turning traffic needs to ignore the signal head. Therefore we
need to extend the right turn connector so that it starts upstream of the
signal head. We then place the stop sign, configured for RTOR, on the
connector at the same position as the signal head.

This will accomplish two goals; firstly the right turning traffic will ignore the
signal head completely and only pay attention to the stop sign. Secondly
the through moving traffic will only pay attention to the signal head and
ignore the stop sign (we don’t want through vehicles proceeding through
the intersection during red phases).
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3.5.10 Activity Lesson 3-11
“Configuring a Signal for Right Turn on Red”
Objective:

To become familiar with placing detectors in the proper locations as well
as assigning them to the appropriate signal phase

Objects Used:

. Stop Signs

Procedure:

i Open the file “3-11.inpx”
2. Save as a new file

3 Complete the task below.
Task:

The Northbound, Westbound, and Southbound approaches have shared

through-right turn lanes. Configure those to be RTOR

1. Extend the NBR, WBR, and SBR connectors just upstream of the
signal heads in their shared lanes.

2. Place stop signs on the NBR, WBR, and SBR connectors so that the
right turning vehicles will stop at the same point as through moving
traffic.

3. Configure the stop signs for RTOR with their associated through
phase.

The Eastbound approach has an exclusive right turn lane controlled by

overlap phase 9.

4. Edit the existing signal head to not apply to any vehicle classes.

a. Double Left-Click on the signal head
b. In the signal head editor under the vehicle classes box hold
Ctrl and Left-Click on All Vehicle Types.

5. Place a stop sign at the same — — ,

point on the link s o, =

6. Configure the stop sign for \ -
RTOR.

No.: 9 Name:

, lLocaﬁon‘ RTOR ITlme Distribution l

Only on Red:

© PTV Group 2017 50



4

Scenario Management and Importing ANM

4.1 Scenario Manager

Vissim’s Scenario manager allows users to model and compare Vissim
networks that depict a single study area under varying conditions; be-it
time of day traffic flow (AM versus PM), future demand modeling, new
constructions, or alternative build designs.

Scenario manager can also be used as a tool to notate and communicate
with other users who may be working on the same file. Even if a Vissim
model only has one scenario it can be beneficial to use Scenario manager
to keep track of changes that are made to the network.

At its core Vissim’'s Scenario Manager has three main components; the
Base Network, Scenario Networks, and modification files. Vissim’s internal
structure behaves as follows:

1. The base network is built.

2 Scenarios are created identical to the base network.

3 Modifications are created that alter the base scenario in some way.
4. Modifications are applied to specific scenarios.

Each unique scenario is the base scenario with a collection of
modifications applied to it.

411 Placing a model under Scenario Management

To place a model under scenario management follow these steps:
1. Open the *.inpx file in Vissim.

2. Open the File menu—>Scenario Management

3. Select Place Under Scenario Management.

4. Select a project name and name the first scenario.

It is common practice to have Scenario 1 be an exact copy of
the base network and therefore named “Base”.

This will convert the existing Vissim model into the base network and
automatically generate scenario one from the base network with no
modifications.
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4.1.2 Base Network
—

The base network is the starting point and foundation of the Vissim model.
It consists of the basic geometry and calibration of the study area. The
base network serves as the blueprint for every scenario in-that each
scenario is created from the base network.

Changes made in the base scenario carry over to all scenarios and are
applied before modifications take effect. Generally the base network
should be built and calibrated before creating multiple scenarios.

Simulations and evaluations cannot be performed in the base network. It is
common practice to have scenario 1 be identical to the base network (no
modifications applied to scenario 1) for testing and calibration purposes.

41.3 Scenarios
| e ]

Scenarios allow users to perform simulations and evaluations on the base
network with specific modifications active. Each scenario, at its core, is the
base network with a set of modifications applied to it.

4.1.4 Modifications
e=——— = ——————— ————— . e —_.]

Editing a scenario will override any conflicting geometry or settings in the
base network only for that specific scenario. Vissim tracks these edits in
the form of Modification files.

By default, a modification applies to only the scenario the user currently
has open. However this modification may be applied to multiple scenarios
at the same time.

Modifications can be retroactively edited or disassociated with particular
scenarios.

Any changes that need to be made globally (to all scenarios) can either be
made in the base network or as a modification that is associated with all
scenarios.

It is important to note that modifications do not apply to the base
network.
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4.1.5 Project Explorer

The project explorer is a tool used to
navigate between the base network,
scenarios, and modifications. It displays the
names of each scenario as well as a map of
which modifications apply to each scenario.

The base network, scenarios, or even
specific modifications may be accessed by
double-clicking on the title in the project
explorer. It is in the project explorer view
where users create, duplicate, or delete
scenarios or modifications.

4.1.6

iR X | o
Q»tpiAivport'VE}
- )¢ Base network
- Scenarios
i [g)fg 1: Existing
¢ ) 2 Future-No Build
[ @) 3000
g {4, 1: Add Lane to Arterial
& Modifications
L%y 1: Add Lane to Arterial
I_%, 2: Add Turn Bay
L _ -k, 3: <generated automatically>

Project Structure Interface

The project structure interface can be accessed in the project explorer by

2

clicking the == button.

4.1.6.1 Basic Settings Tab

# f
In the Project Structure interface users can find a log of changes made to

the entire Vissim project. Some log entries are automatically kept and
times tamped each time a scenario or modification is created.

Basic settings |Sunarios I Modiﬁcatior\sl

Project name: Intersection l.ayT':uts

Log: C_ount:ﬁ No | Date | Entry

1| 1/12/17/20155:3150P |Modifikation 4: has been created.

3| 3(12/17/20155:3952 P |Modifikation 4: has been crested.

5 5/12/17/20156:0216 P |Modifikation 4: has been created.

2| 2/12/17/20155:3438 P Modifikation 4: <generated automatically> has been deleted.
a4 4/12/17/20155:4708 P |Modifikation 4: <generated automatically> has been deleted.

6 6/12/17/20156:0216 P Modifikation 4: <generated automatically> has been deleted.

Log entries can also be manually entered using the + button. Users |
working in teams or in conjunction with modeling subcontractors can use
this log to communicate and track changes made to the project file.

Even if the Vissim model only has one scenario, users can use this feature
in the Scenario manager to track key model milestones.
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Scenarios Tab

The scenarios tab keeps a list of all scenarios in the model. There are
spaces for descriptions of each scenario as well as a field to assign
modifications to each scenario.

(s R

| Basic settings | Scenarios | Modifications|

E‘ﬂjl No | Name | Dgsirigﬁfag_‘l Directory | Modifications \ ('-----A tenat Moc Conc A ] ScenToComp -
‘1| 1Unsignalized Intersection | (C\Users\Public\D (13 31 113 23
2| 2/Signalized Intersection (C\Users\Public\D | | | 13
3/ 3{Roundabout 11,2

_ (C\Users\Public\D |[7]FREF T m e P e e o a
2: <generated automatically>
[7]3: <generated automatically>

][8)[X][&)[+]

From this list scenarios can also be created, duplicated, or deleted.

Modifications Tab

The modifications tab keeps a list of all modifications in the model. A
modification can be created and not used. Each scenario may also have
numerous modifications applied to it; therefore this list may be quite
extensive in a mature model. Users can create, duplicate or delete
modifications in this window. This tab also allows users to notate and
check modification compatibility.

I

(Projed Structure
Basic settings l Scenarios | Modifications
Count: 3| No LoadIndex Name ‘ Description Group | TraFileName | Exclusions DependOn
1 1 1 <generated aut 1 MO000O1 trax.
i 2|<generated aut| 2 _M000002trax |
3 3 3| <generated aut| i _[M000003 trax | N

FEXEE

RIE

i

Some modifications are inherently incompatible or should not be used
together. This tab allows users to check whether two modifications can be
used together before being applied to a scenario.
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| @{

These restrictions can be checked using the | " | putton and tracked in
the Exclusions field.

For example:

If in modification #2 a vehicle input is placed on link #5 but link #5
is was deleted in modification #1, then modification #2 can only be
applied to scenarios that are not associated with modification #1.

Therefore in the exclusions field for modification #2, modification

#1 will be selected

Conversely, some modifications are not mutually exclusive and must be
applied either together or not at all.

These dependencies can be checked using the

Ed
button and tracked

in the DependOn field.

For example:

If in modification #2 a vehicle input is placed on link #5 but link #5
is was created in modification #1, then modification #2 can only be
applied to scenarios that are associated with modification #1.

Therefore in the DependOn field for modification #2, modification
#1 will be selected.

“*NOTE** It is good practice to heavily notate your scenarios and maodifications.
It can be easy to lose track of what each specific modification does and why a
user created it or used it.

Recommendation:

‘At the very least use the log in the Basic Settings tab every time a user opens or
closes the model. This can help colleagues, managers, and reviewers follow |
how each scenario differs and what changes were made.
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4.1.7 Activity Lesson 4-1

“Scenario Management Basics”
(=== ———— = — = = = e

Objective:
This activity will introduce how to place a file under scenario management.

Objects Used:

o File menu

e ANM import Dialog
*.anm files

Procedure:
1. Open the file “4-1.inpx”
2. Complete the task below.

Task 1:
1. Place the file under scenario management

a. Go to File -> Scenario Management -> Place Under Scenario
Management...

b. Name the project “Activity 4-1"Name the first scenario “Base
Simulation and Results”
2. Add an AM and PM scenario
Open the Project Structure Window
Select the Scenarios Tab
Press the + button
Name it “Activity 4-1 AM”
Press the + button
Name it “Activity 4-1 PM”
3. Notate your actions in the Basic Settings tab by adding your name to
the log entry (for example, “Scenario 2: has been created by "
Close the Project structure interface
Edit Scenario 2 (AM)

a. In the Project explorer menu double left-click on Scenario 2
(AM) to open it (your window headers will turn green when
editing a scenario).

b. In the Vehicle Inputs list copy the data from the column
AM_Volume_Data into the Volume(0) column. The
AM_Volume_Data is an user defined attribute containing the
AM Volume.

c. Edit the relative flows in the Static Vehicle Routing Decisions
list

"0 o0 UTw

S
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i. Select all Routing Decisions (all rows in the left side
list)

i. copy the data from the AM_TurnCount_Data column
into the RelFlow(0) column

d. Save the scenario by pressing the save button or going to
File—Save Scenario

6. Edit Scenario 3 (PM)

a. n the Project explorer menu double left-click on Scenario 3
(PM) to open it (your window headers will turn green when
editing a scenario).

b. In the Vehicle Inputs list copy the data from the column
PM_Volume_Data into the Volume(0) column

c. Edit the relative flows in the Static Vehicle Routing Decisions
list

i. Select all Routing Decisions (all rows in the left side
list)

ii. copy the data from the PM_TurnCount_Data column
into the RelFlow(0) column

d. Save the scenario by pressing the save button or going to
File—Save Scenario

7 Notice there are now two modifications generated automatically. We
should note which one is which for later reference.

a. Open the project structure interface

b. Open the modifications tab

c. Rename Modification 1 to “AM Volumes and Relative Flow”

d. Rename Modification 2 to “PM Volumes and Relative Flow”

Task 2 (optional):
1. Create an arbitrary modification not associated with any scenarios.
a. In the project structure window, under the modifications tab,
press the + button to add a new empty modification.
b. Name this modification “arbitrary link”
c. Close the window
d. In the project explorer you will see the new modification in the
list. Double left-click on it to edit the modification (your window
headers will turn red when you are editing a modification).
e. Draw an arbitrary link across the network that is easily noticed
at a glance.
f  Save the modification by pressing the save button or going to
File—Save Maodification.
2 Add modification 3 to both scenario 2 (AM) and scenario 3 (PM)
a. Open the project structure window
b. Open the Scenarios tab
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d.

Under the Modifications column add modification 3 to
scenarios 2 and 3
I. Select the box in the modification column and row 2
ii. Using the drop down also check modification 3 (keep
modification 1 checked)
iii. Repeat the process for scenario 3
Close the window

3. Open Scenario 2 (AM) and check whether the new link is present.
4. Open Scenario 3 (PM) and check whether the new link is present.

Task 3 (optional):
1. Edit the Base Network

a.

b.
o3

Double left-click on the base network in the project explorer
(the window headers will turn gold when editing the base
network)

Draw an arbitrary link that is easily noticeable

Save the base network by clicking the save button or going to
File—»Save Base Network

2. Open Scenario 2 (AM) and check whether the new link is present.
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4.2 Importing ANM files

Up to this point we have created
network geometry, configured the
demand and placed control
devices to mitigate conflicts
manually. However if there is an
existing model of the study area
why go through the trouble of
building it from scratch?

*NOTE** It is recommended that
models built in third-party software
(not PTV Visum or PTV Vistro) be run
through either Vistro or Visum first as
the conversion form deterministic
models to microsimulation can be
complex if not in the correct format.
Leading to discrepancies in network

geometry

Perhaps there is a regional
strategic planning or traffic demand model builtin a platform like Visum
where origin-destination assignment is already calibrated or trip-based
assignment has been applied.

Or perhaps there is a capacity or traffic impact analysis model built in a
platform like Vistro where the signals have been coordinated and
optimized as well as HCM data has been generated.

The good news is all of these types of models can be brought into Vissim
fairly painlessly (assuming the models were exported correctly from the
other software).

The files exported from Visum or Vistro are *.anm files. These are the
cleanest and most direct imports into Vissim from planning or deterministic
models.

ANM files bring in network geometry objects (Links through Public Transit)
as well as background data such as speed distributions, vehicle
compositions and signal timing.

To import ANM files follow these steps:
1. Open the File menu
2. Hover over the Imports option to expand the list
3. Select ANM an import dialog will open
a. Static Network Data-

i. Press the “...” button and navigate to the
appropriate *.anm file

ii. Press Open

b. Dynamic Traffic Data- This section is for dynamic routes
which are covered in the Vissim Advanced course DTA.
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c. Save As- This section defines where the final import will
be saved.

4. Press Import.

4.21 Activity Lesson 4-2
[=—==———————" " = =L - T = e ————— |

Objective:

To become Familiar with importing ANM files and to see how much of the
network coding can be skipped using the import options.

Objects Used:

e File menu

e ANM import Dialog
*.anm files
Procedure:
3. Open the file “4-2_blank.inpx”
4. Complete the task below.

Task:

1. Import the 4-1.anm file

Open the File menu

Select Import—>ANM

Check Import Network Data

Select the file 4-1.anm

Select Static Routing

Deselect Import Routing

Save the Vissim Input File

Deselect Show Warnings During Import.
i.  Click Import.

2. Adjust any abnormal link geometry

3. Run a simulation

T@me oo
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5

Vehicle Types and Classes

Vissim uses two methods of identifying vehicles; vehicle types and vehicle
classes. Each is used in different ways within Vissim and it is up to the
user to determine how specific or how generalized these classifications
are.

The U.S. Department of Transportation’s Federal Highways Administration
provides a guide for vehicle classification. The FHWA uses thirteen
classifications of vehicles defined by the number of axles and trailers.
Vissim by default uses six rather general classes; car, hgv, bus, tram,
pedestrian, and bike as well as seven general vehicle types; car, hgv, bus,
tram, man, woman and bike.

5.1 Vehicle Types

#

Vissim defines a vehicle type as a group of vehicles that share similar
characteristics.

Physical Characteristics

1 . . .
: . . Model Distributions can be
The basis for each Vehicle type I1s a created in the Base Data

collection of 3D models, called a 2D/3D Menu under Distributions-
model distribution’, that determine the | 20D/3D Models

physical space each vehicle of that type will
occupy, the vehicles’ lengths, widths,
heights, number of axels and silhouettes are
all based on the 3D model distribution. A
distribution is used to provide some variation
from one vehicle to the next.

A vehicle’s2 color is also based on a color
distribution”.

Performance Characteristics

2Color Distributions can be
created in the Base Data
Menu under Distributions-
Colors. However the color
distribution can be overwritten
by the use of a “Color
Scheme”

3acceleration functions can be
defined in the Base Data
Menu under Functions.

Vehicles of the same type share common maximum acceleration and
deceleration functions as well as common desired acceleration and
deceleration functions®. These distributions determine how fast vehicles
accelerate or brake in comfortable (desired) and emergency (maximum)
situations. For example a car might accelerate more quickly than a large
truck (significantly more) so cars and large trucks must not defined as the
same vehicle type.
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1
2.

5:1.1 Creating Vehicle Types
== - —— — — e

To create a vehicle type follow these steps;

Open the Base Data menu

Select Vehicle Types
to open the vehicle
types list

Press the + button to
create a new entry.

The Vehicle type editor
will open automatically.

a. Category: this
entry  defines
certain  global
parameter (i.e.
does a grade
affect
acceleration?).

b. Vehicle Model:
this entry is
where the
2D/3D  model
distributions are
selected for this

type.

c. Maximum
Acceleration:
select the
function that
will define how
fast this vehicle
can accelerate.

" Vehicle type [ x|

| No: 1 Name: Taxi

Static  Functions & Distributions | Special External Driver Model

Category: Car

Vehicle Model: 10: Car

Length from 3.75 to 476 m

Width: from 1.85 to 207 m

Colors

|| Color 1; 1: Default v
Color 2 None il
| Color 3: None v ]‘

Color4: None adlll |
|
‘\
|

OK Cancel
B Vehicle type u

No.: 1 Name: Taxi

Static | Functions & Distributions ' Special Extemal Driver Mode!

Maximum acceleration:  1; Car (3.50 m/s2, 250.00 kmi/h) V:

Desired acceleration:  1: Car (3.50 m/s2, 250.00 km/h) v

Maximum deceleration: 1: Car (-7.50 m/s2, -5.10 m/s2) v

Desired deceleration:  1: Car (-2.75 m/s2, -2.75 m/s2) v

Weight: None

Power None
|

QOccupancy 1: Single Occupancy N(1.00, 0.00) N

OK Cancel

d. Desired Acceleration: select the function that defines
how fast the vehicle type wants to accelerate.

5. Click OK to save the settings.
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5.2 Vehicle Compositions

Vehicle compositions are used by vehicle input points to determine what
types of vehicles come into the network and in what proportions. The
vehicle composition can be changed after creating an input but there must
be at least one composition created prior to placing an input.

PEDESTRIANS

Please note that within Vissim, pedestrians are to be treated like vehicles
in all circumstances (3D models, distributions, vehicle types, vehicle
classes and vehicle compositions) while there are options for Pedestrian !
Types, Pedestrian Classes and Pedestrian Compositions, these objects
are used within the Viswalk software and are not to be confused with
Vissim pedestrians which can be found in vehicle types classes and !
compositions.

5.2 Creating a Vehicle Composition
To create a composition (cross-section) of vehicle types follow these
steps;
1. Open the Traffic menu
2 Select Vehicle Compositions to open the vehicle compositions
list
3. Within the list press the + button to create a new vehicle
composition.

4. Open the Relative Flows child-list

5. Within the child list press the + button to add a new vehicle type to
the composition

6. Define the relative flow for each vehicle type

7. Define the initial speed for each vehicle type

Vehicle Compositions / Relative Flows

Select layout... WAk . b AR S & | Relative flows BB - AR I AEE b=l
Count: ll No | Name | Count: 2' VehType | DesSpeedDim‘ RelFlow |
Y | | Relative flows 1 ferm ————
1| 1 Default ——— - ‘I‘LO_O:Car [50:50km/h | 0.980
2200: HGV [50: 50km/h | 0.020,
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5.2.2 Vehicle Classes

Vehicle Classes are collections of vehicles that share similar driving
behaviors, routes, seed distributions and many other driving
characteristics. Within Vissim many objects reference vehicle classes;

static routes, Desired Speed Decisions, Driving Behaviors, Signal Heads,
etc.

52.3 Example 5-1

“Vehicle Classes”
e ——————————. . - - e |

Vehicle classes and types can easily be confused and often are by many
new users. If the FHWA defines thirteen types of vehicles, a Vissim
modeler might define vehicle classes in the following way:

1. Private transportation- Vehicle types that model drivers
commuting, running errands, on vacation, non-commercial traffic.
General traffic with a variety of driving styles (wide distributions)

a. Motorcycles

b. Passenger cars

c. Light trucks

d. Recreational vehicles

2. Public transportation- Mass transit road-based vehicles.
Schedule based routes. Familiar with the region. More aggressive
driving styles.

a. Busses
b. Shuttles
c. Taxis

3. Commercial vehicles- Vehicles on delivery routes (Frequent
stops). Construction equipment (can use special detours or lanes)

a. Tow trucks
b. Delivery Vans
c. Construction equipment

4. Heavy Goods Vehicles (HGV) - Commercial freight trucks
(tractor-trailers). Multiple axles, multiple trailers, heavy (restricted
routes over bridges)
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5.2.4 Creating a Vehicle Class

To create a vehicle class follow these steps;

1. Open the Base Data menu

Select Vehicle Class to open the vehicle classes list

2
3. Press the + button to create a new entry.
4

Define the vehicle class specifics

a. VehTypes: this entry defines the specific vehicle types
that are included within this class

b. Use Vehicle Type Color. when this box is checked the
vehicle types’ color distribution is used

c. Color: when the Use Vehicle Type Color box is left
unchecked Vissim will display the selected color for all
vehicles of this class

Vehicle Classes

Select layout... v Hd w201 @& <Singlelist> -REARRHE
Count: 6 No; Name VehTypes; UseVehTypeCoIor| Color

i 10ce 0 | @ [M25.000
2] 20HGV 200 | el M (255,0,0,0)

3| 30Bus 300 | 0 |Wl255,255,0,

4 40Tam  |400 | ¥ 255000

5| 50|Pedestrian |510520 | [ /Ml (255,0,0,0)

6| 60/Bike 600 | vl I (255,0,0,0)
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5.2.5 Activity Lesson 5-3
“Vehicle Types, Classes, and Compositions”

Objectives:

To become familiar with defining common vehicle types to be used in a
simulation of a freeway segment.
To become familiar with creating compositions of vehicle types within a
freeway model.
To become familiar with creating vehicle classes for use in a freeway
model.
Objects Used:

e Vehicle Types

e Vehicle Compositions

o Vehicle Classes
Procedure:

1. Open the file “5-3.inpx”

2. Save as a new file

3. Complete the task below

Task:

1. Create or Adjust the following vehicle types:
a. SOV- Select Car and rename it SOV
b. HOV-
i. Duplicate SOV and rename the duplicate HOV
ii. Assign the HOV Occupancy Distribution to HOV
c. Bus- Assign the Bus Occupancy Distribution to Bus

2. Create the following vehicle classes:

SOV | HOV | HGV | Bus
1: All X X X
2: Commercial X
3: Public X
4: Private X X
5: Single Occupancy X
6: High Occupancy X
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3. Create the following vehicle compositions:

Vehicle Type Speed Relative Flow

Arterial SOV 35mph 60
HOV 35mph 30

HGV 35mph 2

Bus 35mph 8
Freeway SOV 65mph 60
HOV 65mph 30

HGV 55mph 8

Bus 55mph 2
Residential SOV 25mph 55
HOV 25mph 40

Bus 25mph 5

4. Add the Vehicle Compositions to the Vehicle Inputs

Input Composition Input Composition
1 Arterial 7 Arterial
2 Residential 8 Arterial
3 Arterial 9 Freeway
4 Freeway 10 Freeway
5 Freeway 11 Residential
6 Arterial 12 Residential
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6 Evaluations
—

Vissim is used to simulate real-world conditions and also is able to collect
real world data from those simulations; traffic counts, speed data, delay,
travel time or queue length among many others.

However being simulation, Vissim also has access to more specific data
that would be more difficult to collect in the field such as acceleration,
number of stops, distance traveled, dwell times, etc.

Given the breadth of data Vissim can keep track of, it is up to the modeler
to decide what data is collected and how it is collected. Vissim can report
second-by-second information for each specific vehicle, signal head,
detector, lane, or intersection to be processed in a database, with a script,
or in a spreadsheet. Or Vissim can automatically aggregate that
information into time intervals (such as 15 minutes or 60 minutes) or
across groups of vehicle classifications (i.e. SOV versus HOV)

In order to collect any sort of data from the |[oms o orms

simulation, the evaluation tools must be activated. By Configuration |
default none are activated to save processing power Dstabase Configuration |
while bUIIdlng the network. Measurement Definition  » |
To activate the evaluation tools open the Evaluation Sy :

Result Lists »

menu and select Configuration.

Within the configuration window there are three tabs; Result Management,
Result Attributes and Direct Output.
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6.1 Result Attributes (Aggregated Data)

This window determines the data that will be collected and reported within |
the Vissim interface. Each row represents a different source of data and
each respective source has an associated Result List where the data can
be read.

Data from the Result Attributes tab will report aggregated data from time
interval to time interval as well as from simulation to simulation in the case
of a multi-run (maximum, minimum, average and standard deviation).

C )
B2 Evaluation Configuration bX \

Evaluation output directory:  F:\Chapter 2\ l ]

| Result Management 1 Result Attributes iOirec! Output |

Additionally collect data for these classes:

Vehicle Classes Pedestrian Classes

10: Private 1: People
20: Commercial
30: Public

40: Pedestrian
50: Bike

Collect data Fromtime Totime Interval
99999 99999 |
99999 | 99999 |

Area measurements @ ' ]

o

Areas & ramps ‘ ) More...

Data collections 93999 99999 |
Delays 1 1 99999 99999
Links | @ 99999 99999 [ More... ]
Nodes ‘ ] 99999 | 99999 | More.. |
0D pairs (] '

l

Pedestrian network pedovmance?
Pedestrian travel times® ,
99999 | 99999 | More.. |

|

|
Queue counters | fr
Vehicle network perfformance | (]

O ©O © ©o ©o 00 © o o ©o o

Vehicle travel times E [ 99999 99999 | More.. |

\ e ST e = - ,A_:i: _A.Z_.A,‘ — e e i |

@ viswalk Specific Outputs
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Vehicle Classes

By default data is collected on all vehicles and will appear in the results as
(All). If specific vehicle classes are selected from the list, Vissim will report
data collected from all vehicles as well as data collected from just the
selected classes. Data collected from a specific class is shown with the
class number in parentheses. By default no classes are selected.

Vehicle Classes

20: Commercial

30: Public I:> Density(All) | Density(10) Speed(AlI): Speed(10)
40: Pedestrian
50: Bike

Collect Data

By checking this box the collection of data from that specific source is
activated. By default the box is not checked; if this box is left unchecked,
while running the simulation, the result list will remain blank.

From Time

This is the time when Vissim will begin collecting data from this source.
The time is entered as simulation seconds (start of simulation = 0). If there
is a seeding time or a warm-up period when data may be inaccurate or
only the data from a specific time is relevant this value should be changed.

To Time

This is the time when Vissim will cease collecting data from this source.
The time is entered as simulation seconds (start of simulation = 0). Data
collection will continue until either the designated To Time has been
reached or until the simulation stops; whichever happens first. By default
the To Time is set to 99999s to automatically encompass the entire
simulation.

Interval

Vissim will aggregate Result Attributes output data into intervals within the
simulation. Each row of data within a Result List will be a different interval
in the simulation. By default the interval is set to 99999s to encompass the
entire simulation (1 interval/simulation). Interval values can range from 1 to
99999 seconds.
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6.1.1 Results Lists

#

The evaluations configured within the results attributes tab each have an
associated list that displays the specific data Vissim is collecting. These
lists update in real time during a simulation run giving us the opportunity to
look at the data without having to wait for the simulation to finish.

To open a result list
1. Open the Evaluation menu
2 Hover over the Result Lists option to expand the menu
3. Select the specific result list to be opened

Multiple lists can me open at any one time.
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6.1.2 Activity Lesson 6-1

“Collecting Node and Link Data”
=== — —— — —— ——— - ————— . ——

Objective:
To become familiar with configuring aggregate data collection as well as to
become comfortable with opening and reviewing data during a simulation.

Objects Used:
Evaluation Menu

e Evaluation Configuration Window
e Node Results List
e Link Results List

Procedure:

1. Open the file “6-1.inpx”
2. Save as a new file
3. Complete the task below

Task:
1. Activate Node and link evaluation for 10 minutes of simulation with a
5-minute warm-up period.
a. Open the Evaluation menu
b. Select Configuration
c. Set the following:

Collect Data From To Interval

Node X 300 900 600

Link X 300 900 300

2. Open the Node and Link evaluation results lists
a. Open the Evaluation menu
b. Select Results Lists—>Node Results
c. Select Results Lists—Link Segment Results
3. Set Vissim to run two consecutive simulations.
a. Open the Simulation menu
b. Select Parameters
c. Setthe number of runs to 2.
4. Start running the first simulation
5. Press Ctrl+Q to place Vissim in quick mode.
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6.1.3 Attribute Selection
Within each data source type (links, nodes, data collection, Queue |
Counters, Vehicle Travel Times, etc.) there are a number of specific
outputs that
Vissim  records. [ Node Results: Select At

The specific data ,
that is shown in SA“’;bt‘“e S
the list can be (M .. @ 1Em|ssnonsCO! ildelin s
. Bt | || il veebiisbiotatnd Movement\Dlrectlon
customized using [ifl - @ Em{SS{Ons NOx Queuelength
the select - @ EmlsswnsVOC. Queue length (mg{lmum)
attributes &l - ® Eucl cansumplion Vehicles (All |
buton. ¢ [l ® Mavement | |Vehicle delay (average) (AII) 1,
; fj-® Person delay (average) = ’ Stops (All)
When the select '3“': '(’;’”"" " ~ |stopped delay (average) (Al)
: N || ueue len :
attributes button is 9 X|

..... @ Queue length (maximum)

selected it opens

..... & Simulation run

the Attribute G- ® Stopped delay (average) f !

Selection window [-® Stops —
i ... Timeinterval

(ShOWI"] nght) ©-® Vehicle delay (average) _“_l

On the left side of L.@ Alltypes

the window Vissim o-® Vehicles
lists all of the data
types related 'tO @)-=+ Simulation run
that evaluation (.= Timeinterval
source.

The right side of
the window shows
which data types are currently shown in the list.

Data types can be moved from the left to the right using the green | wp
button. | e
— Data types can be moved from the right to Y
B o the left using the red button. L8] |
Simulationrun B
Movement\Direction Data types can be positioned in the list T ,
Queelength I} ysing the black buttons. LT
Queue length (maxumum) (
Vehicles (All) i) The set of data types on the [
‘;f:"s‘f‘\‘il‘;'”(a"e"’ge’ o |§ right reflects the columns of __‘_
= z e deay (average) () data within the list.

SimRun | Movement\Direction | QLen | QLenMax | Vehs(Al) | VehDelay(All) | Stops(All) | StopDelay(All
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6.1.4 Activity Lesson 6-2

“Collecting data on specific Vehicle Classes”
j——=——=-——-- — - ————— —— ——— —— ]

Objective:

To become familiar with adding attributes to a list through the lens of
evaluation results.

Objects Used:

e Node Results List

e Attribute Selection Window
Procedure:
1. Open the file “6-2.inpx”
2. Save as a new file
3. Complete the task below
Task:

Configure the Node results list to show the delay for all vehicle classes as
well as for the private vehicle class (10: Private)

1. In the Node Results list press to edit the list attributes. J“
2. Remove all attributes except for Vehicle Delay
a. Select the attribute on the right.
b. Press the remove attribute button. I X l
3. Add Vehicle Delay for Private Vehicles
a. Press the + next to Vehicle Delay to expand the options
b. Select the attribute 10:Private
c. Press the add attribute button.
4. Click OK to save the settings

Run a simulation and observe the differences between All (All) and
Private (10) vehicle delays.
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6.2 Direct Outputs (Raw Data)

This window determines the data that will be collected and reported !
externally of Vissim; either in a text file or a database. Each row
represents a different data type and has an associated file extension. |

Vs - — - -

Evaluation output directory:  F:\Chapter 2\ [_] 4

Resut Management | Result Atbutes | Direct Output |

| Writeto file Write database From time foﬁme

! Managgd lanes

‘ Area measurements (raw data) ‘1 [ ' 0 99999 \ }

}; Convergence \ ( 1‘ ’ ‘

' Data collection (raw data) \ [ ; 0| 99999 i

i Discharge record | [ i 0 999 ,

' Green time distribution ' ! 0| 99999 l !

|Lane changes I ‘ 0| 99999 [ . More.., ] (
| | |

‘ Nodes (raw data) & [ [ i 0 99999 More.. J‘

' Pedestrian record 9 I £ ‘\ 0| 99999 More.. |

0 99999[ ~ More " ‘]'

[ Pedestrian travel times (raw dataﬂ [ 0| 99999 l

Public transport waiting times | [

Signal changes

I Signal control detector record
|

|
iVehicIe input data

1 Vehicle record

|
|
J
]
|
]
|
|
| =
| Pedestrian travel times (OD dala)q' ]
J
|
]
|
|
|
|

|
I
| SSAM }
\
|
i

!Vehicle travel times (raw data)

@ viswalk Specific Outputs

Data from the Direct Output tab will report raw data (non-aggregated) with
a new line of data for every time step; as a result these files can often
become very large. Text files can be imported into other data processing
software to be post-processed. (
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Write to File / Write to Database

At least one of these boxes must be checked in order for Vissim to output
data of the desired type.

From Time

This is the time when Vissim will begin collecting data from this source.
The time is entered as simulation seconds (start of simulation = 0). If there
is a seeding time or a warm-up period when data may be inaccurate or
only the data from a specific time is relevant this value should be changed.

To Time

This is the time when Vissim will cease collecting data from this source.
The time is entered as simulation seconds (start of simulation = 0). Data
collection will continue until either the designated To Time has been
reached or until the simulation stops; whichever happens first. By default
the To Time is set to 99999s to automatically encompass the entire
simulation.

6.2.1 Direct Output Files
e = . = == == ]

If write to file is checked data will be saved in a text file with a unique
extension. The name of the text file is the same as the Vissim file with the
addition of the simulation run number. The following is a list of some of the
more common file extensions (more are found on page 926 of the Vissim
user manual)

Data Collection (Raw Data) ......cccciieiiiimmmmmnennniieermnnneeassseressnsssssns *.mer
VENICIE REGOT «oocsuususmumvsmnsssmvssemsamsmsiammsssmmms s ivus e *fzp
Node Evalustion (RarDala) ...conamnmasmensssnsssmsasrsenmmiies *knr
Sldnal LISiecior ReBilll.evssisussvssrimvisaisisssss s *ldp
Travel Tinmes:(Raw LIata).cisrsmssisnmessimimsvsimnsmssidi *.rsr
Lane GHANGSS st mssssameisssisas s v *.SpwW

These files are saved in the same directory as the Vissim model file
(*.inpx) and the signal controller files (*.rbc).

This data is not aggregated and often requires post processing or extra
analysis.
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6.2.2 Activity Lesson 6-3
“Direct Outputs and Raw Data Files”

Objective:

To become familiar with configuring direct outputs and working with direct
output files.

Objects Used:
e Direct output configuration
e Vehicle record direct outputs
Procedure:
1. Open the file “6-3.inpx”
2. Save as anew file
3. Complete the task below.
Task:
1. Open the Evaluation menu
2. Select Configuration
3. Open the Direct Output tab
4. Configure the vehicle records evaluation
a. Select Collect Data
b. From 300s
c. To600s
Run a simulation

6. Open the output file and view the raw data.
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6.3 Result Management

The result management tab contains some settings that control how data
is aggregated.

i Evaluation Configuration
Evaluation output directory:  C:\Users\Public\Documents\PTV Vision\PTV Vissim 8\

Result Management Result Attributes Direct Output

Keep result attributes of previous simulation runs — —

'None

rof current (multi-)run only

® of all simulation runs

| Automatically add new columns in lists

Automatic list export destination
|
i ® File
! Database
|

Available aggregation percentiles =

Count: 1 Value :
185 [

‘ OK Cancel

|

Output Directory

The output directory is by default the same as the model file (*inpx).
However depending on how the data is processed the directory could be
changed to a new location, say a central server, removable drive, etc.

Keep Previous Runs

The three options within this section are designed for different phases of
model creation and calibration.

1. None: this option makes it so every new simulation that is run erases
the data collected on the previous run. This option is useful for model
creation while making minor adjustments to select attributes; set an
attribute, run a simulation, check the data, if it does not look right
change the setting and re run the simulation.
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2. Current Run (Multi-run) Only: this option keeps data of the current
multi-run and automatically deletes the previous multi-run. This option
is useful for final simulation runs after calibration is complete. It
purifies the data ensuring only data sets from the fully calibrated runs
are included. If this is not selected and previous (pre-calibration) data
sets are still within memory, then the aggregated data will be
inaccurate.

3. All Simulation Runs: this option does not automatically delete any
data sets. This option is useful for the calibration phase of model
building; set an attribute, collect data, change the attribute, rerun a
simulation and compare the results. This is the default selection.

Aggregation Percentiles

Data collected from the result attributes tab is not raw data in that the data
is collected over a time interval and then aggregated values are reported.
Most results are reported as average values over the time interval. Some
results are reported as maximums.

For example, Queue lengths (header: Qlen) are reported as average
queue lengths over the time interval but another output in “Queue Length
(Maximum)” with a header “Qlen(max)".

The aggregation percentiles section allows the modeler to define specific
percentiles within data sets. For example, in the image above the 85"
percentile has been defined meaning for any output within the result
attributes tab there will be an option to also output the 85" percentile
value: Qlen, Qlen(max) and Qlen(85").

To define percentiles follow these steps:
1. Right-Click within the available aggregation percentiles box

2. Select “Add”
. ; *“*NOTE** Percentile values can
3. Define the percentile value as an be defined either before  a

integer number (i.e. 85% = 85 simulation or after a simulation.
not 0.85)
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6.3.1 Activity Lesson 6-4
“Configuring Aggregated Data”

Objective:

To become familiar with managing the results of a simulation; controlling
data sets as well as defining result percentiles.

Objects Used:
e Result Management Tab
e Vehicle Record Result List
e Result List Attribute Selection Window
Procedure:
1. Open the file “6-4.inpx”
2. Save as a new file
3. Complete the task below:
Task:
1. Open the Link Evaluations List
a. Open the Evaluations menu
b. Select Results Lists—Link Segment Results
2. Observe the aggregated results from the previous multi-run
Configure Vissim to replace old multi-run data with new multi-run data.
a. Open the Evaluation menu
b. Select Configuration
c. Open the Results Management tab.
d. Select the option keep current multi-run only.
4. Add an 80™ percentile output.
a. Right-Click in the percentile box
b. Select Add
c. Define the percentile to be 80.

5. Run a Multi-Run in quick mode and observe the results.
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6.4 Data Collection Objects

Many evaluations are able to collect
data without any configuration
however there are some that require
physical objects to be defined within
the network. Without these data
collection objects no data will be
collected.

Modes V I;j

Data Collection Paints .
Vehicle Travel Times

Queue Counters

The four objects that can be found within the Network Objects window are
Nodes, Data Collection Points, Vehicle Travel Times, and Queue
Counters.

6.4.1 Nodes

# '

- ) ) -
Nodes have three general purposes; & Nodes - Egb
e Generating intersection-based
output data

o Serving as routing points for Dynamic Traffic Assignment (DTA)

e Mesoscopic Simulation (Meso)

This course only covers nodes for evaluation. DTA and Meso nodes are
covered in more detail in the Vissim user's manual or in the Vissim
Advanced DTA/Meso training course.

Vissim internally does not have a concept of what an intersection is. To
Vissim the network is just a collection of links, routes, signal heads, and

vehicles. The Node object is a way to tell Vissim which objects make up a

particular intersection. It also helps Vissim determine which links belong to

which legs.

6.4.2 Defining a Node

#

After the physical network is created; links, inputs, routes, signals, etc. a
node can be defined around an intersection to tell the software what is an
intersection. A node is defined by drawing a boarder around a space. The
shape is defined by a series of vertexes and edges. Vissim can
differentiate between different turning movements based on the orientation
of the edges of the node.

To define a node follow these steps:

1. Select the Nodes network object
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9.

Hold Ctrl
Right-Click a single time to define the first vertex

Left-Click a single time to define the next vertex. An edge will be
created between the two vertexes

Left-Click again to define anther vertex

Continue placing vertices and edges until there is a single edge
crossing each leg of the intersection.

Left-Click on the original vertex to complete the node

A Node editor window will open. Double check that the “Use for
evaluation” box is checked.

Click OK to save settings

Keep in mind node evaluations (delay, queue length etc.) are not collected
from the edge of the node in most cases. Rather the start of the queue is
defined by the signal head or stop sign. Therefore the placement of the
node does not need to be exact;, as long as it encompasses all control
devices at the intersection it will collect data just fine. The exception to this
rule is on uncontrolled legs of an intersection (2-way stop or roundabouts).

Data Collection Points are data T
collectors that act very similarly

6.4.3 Data Collection Points

Data Collection Paints I

to pneumatic tubes used in the field. Data Collection points are objects
that are placed in a lane and collect data about vehicles that cross over
them. Data is collected about a vehicle the first time step in which the front
of the vehicle passes over the bar in the lane. For multi lane links, if data is
to be collected for the entire link, a data collection point will need to be
defined in each lane.

6.4.4 Placing a Data Collection Point

To place a data collection point follow these steps:

i

2
3.
4

Select the Data Collection Points network object
Left-Click to select the link
Hold Ctrl

Right-Click a single time on the link to place a Data Collection
Point.
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6.4.5 Data Collection Measurements

Since Data Collection
Points are lane-specific
Vissim needs to know if
data would like to be
collected lane-by-lane or
link-by-link. A Data
Collection Measurement is

ntrol Simulation Evaluation ' Presentation Test Scripts Help
Configuration '

Database Configuration

Measurement Definition +  Data Collection Measurements
Window Delay Measurements

Result Lists 1- Area Measurements

essentially a bundle of data collection points. Once all of the data
collection points have been placed Data Collection Measurements will

need to be defined.

To define a data collection measurement follow these steps:

1. Place all Data Collection Points

Open the Evaluation menu

Hover over the Measurement Definition option to expand the list

2
3
4. Select Data Collection Measurements
5

A data collection measurements list will open. Within the list press the
+ button to add a new measurement.

6. In the DataCollectionPoints box select all of the data collection points -
that are to have their collected data aggregated together.

OR

7. Right-Click within the list to open the context menu

a. Add will add a single blank measurement

b. Generate All (Grouped) will generate a measurement for
each link that has a data collection point with all of the data
collection points on that link bundled together.

c. Generate All (1:1) will generate one measurement per data

collection point

6.4.6 Vehicle Travel Times

Vehicle Records, Link
Evaluations and Node

Vahicle Travel Times

evaluations all report travel time or delay results. However Vehicle Travel
Times allow us to collect travel time and delay data between two specific

points in the model.
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To define a vehicle travel time follow these steps:

Select the Vehicle Travel Times network object

Left-Click to select the desired starting link

Right-Click a single time on the location where the travel time
Left-Click a single time at the location where the travel time
A Travel Time Measurement window will open.

Here we can define more precisely the positions of the start and
end points as well as the distance between them.

1.
2
3. Hold Ctrl
4
collections will start
5.
collections will end
6.
8.

Click OK to save these settings

6.4.7 Delay Measurements

Delay results can Dbe
collected based on the
defined Vehicle Travel Time
measurements. Similar to
data collection points, Vissim
doesn't know what travel
times we want to include so

ntrol Simulation Evaluation | Presentation Test Scripts Help

Configuration

Database Coniguation | N

Measurement Defimition + Data Collection Measurements
Window +  Delay Measurements
Result Lists *# Area Measurements

we must define a Delay Measurement.

To collect delay data a delay measurement must be define; follow these

steps:

1. Place all travel time objects

Open the Evaluation menu

Hover over Measurement Definition to expand the list

2
3
4. Select Delay Measurements
5

A delay measurement list will open. Within the list press the + button
to add a new measurement.

6. In the VehTravTmMeas box select all of the travel time objects that
are to have their collected data aggregated together.

OR

7. Right-Click within the list to open the context menu
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a. Add will add a single blank measurement

b. Generate All (1:1) will generate one delay measurement per
travel time object

6.4.8 Queue Counters

Queuing data is collected in i :
5 Cueue Counters
Node evaluation. However

Node evaluations do not report queues that extend through upstream
intersections. Queue counters offer more flexibility on where queue data is
collected. In addition queue data collected with queue counters is not
impacted by nodes upstream. Therefore we can collect true queue data
that includes spillback distances through upstream intersections.

Queue counters report data from the entire link (not lane specific) and
therefore do not require the additional step of defining a measurement like
data collections or delays.

To define a queue counter follow these steps:
1. Select the Queue Counters network object
2. Left-Click to select the link where it will be placed
3. Hold Ctrl
4

Right-Click at the location where the start of the queue data
collection will start.
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6.4.9 Activity Lesson 6-5

“Placing Evaluation Objects”
f=—=——0—0ro-______ - S irs—au - — . — —— — ———————au = = |

Objective:

To become familiar with placing and configuring the data collection objects
Nodes, Data Collection Points, Vehicle Travel Times and Queue Counters
as well as Data Collection Measurements and Delay Measurements.

Objects Used:
e Nodes
o Data Collection Points
e Data Collection Measurements
e Vehicle Travel Times
e Delay Measurements
e Queue Counters
Procedure:
1. Open the file “6-5.inpx”
2. Complete the task Below:
Task:
1. Collect intersection data at each intersection of the interchange
a. Place a Node around the north interchange intersection.
b. Place a Node around the south interchange intersection.
2. Collect volume data for each freeway direction

a. Place a Data Collection Point in each lane of the freeway in
both directions at points E and F.

b. Create two Data Collection measurements, one for each
freeway direction

i. Open the Evaluation menu
ii. Select Measurement Definition—Data Collection
ji. Right-Click in the list and select
Generate All (Grouped)

3. Collect travel time data for each freeway direction
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a. Place a travel time measurement from point Ato C

b. Place a travel time measurement from point D to B
4. Collect delay data for each freeway direction

a. Open the Evaluation menu

b. Select Measurement Definition—Delay

c. Right-Click in the list and select Generate All (1:1)
5. Collect queue spill-back data at the interchange intersections

a. Place a queue counter at point G

b. Place a queue counter at point H

6. Run a simulation and observe the results.
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6.1 Visualizing Results in Vissim

Vissim offers the ability to color network objects, such as links and
vehicles, using a color scheme based on the value of a specific attribute.

For example, depending on the speed of a vehicle, the delay on a section
of a link or the density of a lane, Vissim will assign a different color based
on user defined thresholds.

In this way we can use Vissim’s color schemes to review a model for
quality assurance/quality control, help calibrate congestion by generating
heat maps, and Create visual representations of our data to better
conceptualize our results.

6.1.1 Link Heat Maps

Using a color scheme to generate a heat map is a quick way to evaluate
links and the network conditions in Vissim. This feature can be used to
distinguish bottlenecks and any irregularity in the model. Congested areas
may be expected as part of the simulation of the model; however there are
cases that having a bottleneck on the roadway does not make sense.
Digging through thousands of lines of raw outputs or determining if a
certain result is reasonable can be very difficult. Using a heat map allows
us to quickly identify congested areas or locations of underperformance.

The figure depicts a sample
speed heat map. We can
easily distinguish the
congestion on the south
bound freeway section before
the off ramp as well as the
congestion on the arterial to
the south.

Congestion

The existence of congestion
and bottlenecks is not
necessarily a result of poor
modeling. If the field data
shows that there is
congestion in the field, the
model should reflect the
same pattern.
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6.1.2 Creating a Heat Map on Links

To configure the links to display a heat map based on a specific attribute,
in this case speed, follow these steps:

1. Activate Link Evaluation on the desired links
a. Open the Links list.
i. Right-Click on the Links network object
ii. Select“Show List’
b. Add the attribute “Link Evaluation Active” to the list.

i. Inthe links list press the attribute
selection button

ii. Select and move the “Link
Evaluation Active” from the right to the left.
jii. Click "OK”

| | Filters... l | Decimals , ShowUnits ‘ Alignment | Format

Number ' (1 |Right Default
Name 1 |Left |Default
Link behavior type | |Left Defauit
Display type | |Left |Default
Level | lLeft | Default
Number of lanes |Right [Defavlt
: . Length 2D ‘Right 'Default
Link evaluaho.n segment len I conmector (Center Default
Look ahead distance for ove From link (Left \Default
Meso follow-up gap To link Left 1Default

Meso speed (Center Defauit
Mesorspeed model |Center | Default

,'

Lane changes evaluation actq
Length 20

Length 3D

Level

Link behavior type

L
®
®
L
|
o
=
L4
®
®
®

Has overtaking lane
Link evaluation active

ocoOocowooo0o0oC

c. In the Links list check the box in the “LinkEvalAct” column
for the desired links

Select layout... v ’ | 4
Count:dl No} LinkEvalAct
1] 1 o
2 2| 0
3 3 v
7 =T
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2. Open the Links color scheme configuration window
a. Right-Click on the Links network object
b. Select Edit Graphic Parameters

c. Inthe “Drawing Mode” field use the dropdown menu to
select “Use Color Scheme”

3. Select the attribute we want to base the color scheme on

Emissions NOx
Emissions particulates
Emissions 502

a. Select Link Segments -
b. Select the Attribute

0000

—_————— 5! Emissions soot
B Edit Color Scheme for Links [ || | @ End
| g
| Classification based on e L
..... # Index
‘; () Lanes ...# Lane
@ Linksegments 3@ ~ |If i % 'Length
...# Link
Classification by color -0 {Speed!

Attribute! 3b a’ P Current run x Current x All types

e RS e e e Ea st | [ ;.. Current run x Last completed x Al
Speed(Current, Current, All) (Unit: mph | 4

pesel & A & t/ i Current run x Total x All types

4. Define the range of values for each color.

a. Wecan chopse pre-defined color D - ],r
schemes using the pull-down menu |
b. Or we can define our own (Speed |
i. Right-Click in the white box e Bl
ii. Select Add Relative lost time

ii. Define the color and the value range

Class bounds and colors: 4
Count: 11! LowerBound UpperBound Color

1 MIN 3.728 [0 (255, 255, 128, 259)
2 3.728 7.456 [l (255, 255,0,0)
3 7.456 11.185 [l (255, 255,128, 0)
4 11,185 14.913 [0 (255, 255,198, 0)
5 14,913 18.641 [] (255, 255, 255, 0)
6 18.641 22.369 [0 (255, 198, 255, 0)
7 22.369 29.826 [T (255, 128, 255, 0)
8 29.826 37.282 [ (255, 0, 255, 0)
9 37.282 44.739 [ (255, 0, 187, 0)

10 44,739 74.565 [l (255, 0, 128, 0)

1 74.565 MAX [J (255, 255, 255, 255)
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5. Click “Ok”.
6. We need to then activate Link evaluation.
a. Open the Evaluation menu
b. Select Configuration
c. Activate Link evaluation
d

Determine the interval length. This will dictate the refresh
rate of the heat map. For example if we want a new heat
map for every 15 minutes set the interval to 900s.

e. Click “OK".

7. Run a simulation to update the colors.

*NOTE** The described process will change all link lanes to the same colors.
If you want lane-specific heat maps you will need to change the link evaluation
from “Link Segments” to” Lane Segments”
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6.1.3 Activity Lesson 6-6
“Creating a Heat Map on Links”

Objective:

To generate a heat map based on the average speed on a link
segment over 15 minutes of simulation. By the end of this activity
we should be able to select an attribute to use for a color scheme,
define the ranges of values for each color, define the heat map
refresh rate, and identify congested areas in the network.

Objects Used:

. Link Lists
. Link Graphic Parameters Editor
. Evaluation Configuration Menu
. Help Menu
. Demo Files

Procedure:

1. Open the help menu and navigate to Example Files > Demo directory
2. Open the file “Roundabout Billings.inpx” by dragging the *.inpx file into

the network editor window. [—
3. Save as a new file. : ::n»‘be-r—.lir[m
4. Open the Links list and activate Link evaluation Speed |
on ALL links Density
5. Open the link graphic parameters and create a Volume
speed based color scheme using the following: UpperBound | Color
a. Use the pre-defined speed color scheme 5.000, (255,
b. Modify the ranges of each color 7.500 [ (255,

10.000 [ (255,

6. Open the evaluation configuration =ohE
and activate link evaluation 23‘200;8(255-
7. Using the “More” button select “Lane Segment’ 25'000:[1822'
- | )
to copvert the color scheme to lane- by lane 35.000/ (255,
colorization. 45.000 [ (255
8. Define the interval to be 900s 55.0005.(255,
9. Run a simulation and determine where the hot 75.000 [l (255,
MAXI[] 255,

spots are in the network
10. Discuss whether these are a result of speed control or congestion.
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6.1.4

Color Vehicles by State

In the same way that we colored links in the previous section, we can also |
use color schemes on Vehicles in the network based on specific attributes
of the vehicles such as speed, acceleration, occupancy, etc.

We can also
use Vissim to
display a
vehicle’s  color
based on each
vehicle’s driving
state. Unlike
using a color
scheme, when
coloring a
vehicle by its
state, we cannot
edit the colors or
what  attribute
the color s
based on. Here
is a table
showing what
each color
represents:

Using the color
vehicles

by state
functionality is
an efficient way
to perform
QA/QC on the
network,
troubleshoot
some
unexpected
behavior, or just
to get a sense of
what  vehicles
are doing in

certain areas of the network.

Color Description
White In the queue mode. At least one
I queue counter should be specified.

Light == Waiting for lane change after 6s in

Blue the emergency stop position.
[range Wants to change lane due to vehicle

|| route

Light In the process of changing lanes.
Green -

Dark Afterlane change: lane change was
Green performed in the last 6s.

Dark Brakes to change lane: vehicle

Red brakes, as it needs to change lanes.
Amber Cooperative braking.

Red Sleep: vehicle which is not paying

attention to the driving.

Dark Vehicle is ignoring signals

Yellow

Pink . Heavy breaking

|
Purple Moderate breaking from -3.0 m/s? to
-1.0 m/s?
Navy Default view.
Blue

93

© PTV Group 2017 ©




6.1.5 Activity Lesson 6-7
“Color Vehicles by Driving State”

Objective:

By the end of this activity we should be able to color vehicles in a
simulation by their driving state as well as hot to use this feature to
determine how vehicles are reacting to reduced speed areas and conflict
areas.

Objects Used:

. Vehicles in Network Graphic Parameters
. Quick View Window
. Demo files

Procedure:

1. Open the help menu and navigate to Example Files > Demo
directory

2. Open the file “Roundabout Billings.inpx” by dragging the *.inpx file
into the network editor window.

Save as a new file.

4. Configure the “Vehicles In Network” network object to display by
vehicle state:

a. Right-Click on the “Vehicles in Network” network object
b. Select Edit Graphic Parameters

c. Inthe “Drawing Mode” field use the dropdown menu to
select “Color by Driving State”

Run a simulation and observe when vehicles are changing colors

6. Discuss where the different states occur most often.
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Driver Behaviors

In this chapter we will explore some of the underlying processes that
control how vehicles interact within the lane and during lane changes.

Vissim is not a black-box platform in that all of the driving behaviors are
viewable and editable. In this way a model can be customized to match
the driving styles of the region the model is emulating.

Car following model is the heart of the microsimulation model. It affects
multiple important performance measures such as speed, volume, and
density. Vissim provides two different following models; one for urban
following and one for freeway following.

The following behaviors of vehicles in freeway segments drastically impact
the performance of a Vissim model and in fact provide the highest level of
impact to the calibration. In urban areas, the effects of objects like signal
heads, conflict areas, reduced speed areas and acceleration functions
have a much larger impact on the performance of the model. It is for these
reasons that the freeway following model is more complex and why we will
be looking into it in greater detail in this section.

The objective of this section is to highlight some of the most important
parameters in the freeway following model. We will explore the impact
they have on our models. However many of these should be left as
defaults and only be adapted by an experienced user.

It is within the driving behaviors where we define parameters such as how
far vehicles can see ahead or behind, how many vehicles they can react to
at any one time, where they drive within a lane an how to assess
acceptable gaps for lane changes; among many others more advanced
parameters.
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71 Creating a Driving Behavior
eee—-----_—a—-- - ——————— -

Driving behaviors can be found in the Base Data menu. Vissim contains
five default driving behaviors. The two most popularly used behaviors are
discussed within this chapter; Urban (motorized) and Freeway (free lane
selection). However, in this section we will be focusing on the mechanics
of how to make a new driving behavior by adapting one of the defaults.

We will be looking into editing the specific parameters in greater detail in
the next section.

711 Customizing Driving Behaviors
=== .- = ————————  ——————vaon————— |

Driving behaviors can be customized from the o\ :

defaults provided by Vissim. Behaviors can be b YO L Raae Deia
adapted and applied to different vehicles # Network Settings
classes to increase the accuracy of the model. User-Defined Attributes
For example a commuter might drive

differently (more aggressively) than a tourist. ~ 20/30 Model Segments
Changing the cross-section of driving 20/3D Models
behaviors can greatly impact the results of the

model. F t’mc.tuon.s
To duplicate and edit a driving behavior follow Duslf:buhons i
these steps: Vehicle Types
1. Open the Base Data menu Vehicle Classes
2. Select Driving Behaviors to open the Driving Behaviors
list of driving behaviors . .
; ; . ; Link Behavior Types
3. Right-Click a behavior in the list to '
open the context menu Pedestrian Types
4. Select “Duplicate” Pedestrian Classes
5. Right-Click the behavior in the list to Walking Behaviors
open the context menu Area Behavior Types
6. Select “Edit” ol $
7. Configure the parameters within the Display Types
driving behavior editor Levels
8. Click OK to save the settings. Time Intervals

**NOTE** It is highly recommended to duplicate the default driving behaviors and
edit a duplicate rather than just changing the defaults.

Once a default is changed it can be hard to revert it back. It can be easy to over-
calibrate a behavior and having a default to compare to will help.
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112 Link Behavior Types

Vissim does not know if a specific driving
behavior is supposed to apply to all
vehicles on a specific link or to a specific
vehicle class(es). Therefore there is an
intermediate step called a Link Behavior
Type. A Link Behavior Type is a bundle of
driving behaviors that will be applied to a
link.

For example, in a weaving section a
passenger car might behave differently
from a heavy truck. Therefore each will
have a unique driving behavior for this
section of the network. However they are
both applied to the same link so a Weaving
section link behavior type will have to be
created.

Edit View Lists Base Data
Network Settings

User Defined Attributes
2D/3D Model Segments
2D/3D Models
Functions

Distributions

Vehicle Types

Vehicle Classes

Driving Behaviors

Link Behavior Types
Pedestrian Types

Ded v

e Nl
Passenger Cars
" Weaving Behavior

HGV

Z

’ Weaving Behavior

strian Classes
]ing Behaviors

Behavior Types

Driving Behavior Driving Behavi

or !lay Types
Is

N

Time Intervals

Link Behavior Type

} Freeway Weaving Section

=3

To define a Link Behavior Type, follow these steps:

Open the Base Data menu

Select Link Behavior Types to open the link behavior types list

1
2
3. Press the “+” button to add a new link behavior type
4

Use the pulldown to associate a driving behavior with the link

behavior type.
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7.4.3 Activity Lesson 7-1
“Creating and Applying Driving Behaviors”

Objective:

To become familiar with finding and identifying Freeway and Urban driving
behaviors as well as creating Link Behavior Types.

Objects Used:
e Driving Behaviors
e Link Behavior Types
e Link Editor Window
Procedure:
1. Open the file “7-1.inpx”
2. Save as a new file

3. Complete the task below

Task:
Create a weaving section driving behavior.
1. Open the Base Data menu
2. Select Driving Behaviors
3. Duplicate the existing Freeway Driving behavior
a. Right-Click on the Freeway behavior
b. Select Duplicate
Create a weaving section link behavior type
1. Open the Base Data menu
2. Select Link Behavior Types
3. Press the + button to create a new link behavior type
4. Connect the newly created driving behavior to it.
Configure all links that will be using this new behavior.
1. Double Left-Click on link #5 and #9

2. Select the newly created link behavior type.
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7.2 Car Following Parameters

In this section we will be looking more deeply into how Vissim simulated
vehicles interact with one another specifically when they are following one
another. Other driving behaviors, such as lane change parameters, will be
covered in later sections.

7.21 Wiedemann’s General Car-Following Model

The traffic flow model in Vissim is a discrete, stochastic, time step based
microscopic model with driver-vehicle-units as single entities. The model
contains a psycho-physical car following model for longitudinal vehicle
movement and a rule-based algorithm for lateral movements. The model is
based on the continued work of Rainer Wiedemann.

The basic idea of the Wiedemann model is the assumption that a driver
can be in one of four driving modes (see also illustration in section:

’.‘:A Reaction
X threshold
; 1.Free Drivirlg
Free Driving 5
]
2
3 /‘2./Braklng
s B 1gl» A
Safety Distance (Approach)
4. Braking (Danger)
- >
slower same speed faster

1. Free Driving: No influence of preceding vehicles observable.
In this mode the driver seeks to reach and maintain a certain
speed, (in Vissim the desired speed). In reality, the speed in
free driving cannot be kept constant, but oscillates around the
desired speed due to imperfect throttle control.

2. Approaching: The process of adapting the driver's own
speed to the lower speed of a preceding vehicle. While
approaching, a driver applies a deceleration so that the speed
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difference of the two vehicles is zero in the moment the
vehicle reaches the desired safety distance (minimum
following distance).

3. Following: The driver follows the preceding car without any
conscious acceleration or deceleration. The safety distance is
kept more or less constant, but again due to imperfect throttle
control and imperfect estimation the speed difference
oscillates around zero.

4. Braking: The application of medium to high deceleration rates
if the distance falls below the desired safety distance. This can
happen if the preceding car changes speed abruptly, or if a
third car changes lanes in front of the observed driver.

Car Following Model

The following model pull-down selects the basic model for the
vehicle following behavior. Two following models are available as

shown below:

. Wiedemann 74: Model suitable for urban traffic.

. Wiedemann 99: Model suitable for freeway/highway
traffic.

. No Interaction: Vehicles do not recognize any other
vehicles (can be used for a simplified pedestrian
behavior).

7.2.2 “Wiedemann 74” Following Model

== ———— e = e~ . ——— ——— — |

The 74 model is used for urban driving behaviors and is Wiedemann’s
1974 car following model. The following parameters can be modified:

Average Standstill Distance:

Defines the average desired distance between stopped cars. It
has a fixed variation of + 1m.

Additive Part of Desired Safety Distance:

Controls the base headway time; it increases the following
distance based on the speed of the vehicle.

Multiplicative Part of Desired Safety Distance:

Determines the degree of variation between individual vehicles’
following distance.
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7.2.3 “Wiedemann 99” Following Model

The 99 model is used for freeway (uninterrupted flow) driving behaviors
and is based on Wiedemann’s 1999 car following model. Here is a brief
description of its parameters:

CCo
Defines the average desired distance between stopped cars. It
has no variation. This parameter directly impacts jam density.

CC1
s the headway time (seconds) that a driver wants to keep. Ata
given speed, the mean safety distance is computed as:

Safety Distance = CC0O + CC1 * speed

The safety distance is defined in the model as the minimal
distance a driver will keep while following other cars. The higher
the value, the more cautious the driver is. In case of high volumes
this distance becomes the value with the strongest influence on
capacity.

CC2

Restricts the longitudinal oscillation or how much more distance
than the desired safety distance a driver allows before he
intentionally moves closer to the car in front. If this value is set to
10m for example, the following process results in distances
between dx_safe and dx_safe + 10m. The default value is 4.0m,
which results in a quite stable following process.

CC3

Controls the start of the deceleration process, for example when a
driver recognizes a preceding slower vehicle. In other words, it
defines how many seconds before reaching the safety distance
the driver starts to decelerate.

CC4 and CC5

Control the speed differences during the “following” state. Smaller
values result in a more sensitive reaction of drivers to
accelerations or decelerations of the preceding car, i.e. the
vehicles are more tightly coupled. Both parameters should be of
the same absolute value in normal situations (one is for negative
and one for positive speed differences) and the default value of
0.35 is a fairly tight restriction of the following process.

CC6
Influence of distance on speed oscillation while in following
process. If set to 0 the speed oscillation is independent of the
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distance to the preceding vehicle. Larger values lead to a greater
speed oscillation with increasing distance.

CC7
Actual acceleration during the oscillation process.

CCs8
Desired acceleration when starting from standstill (limited by
maximum acceleration defined within the acceleration curves)

CC9
Desired acceleration at 80 km/h (limited by maximum acceleration
defined within the acceleration curves).

*NOTE™** It is recommended to use only CCO, CC1, and CC2 parameters for
calibration purposes unless there is a robust field data collection and research study
behind changing parameters.

7.21 General Following Tab Parameters
P —mmas-—e—s—-T——am———. - . -

Look Ahead Distance _
Defines the distance that a vehicle can see forward in order to react to
other vehicles either in front or to the side of it (within the same link). This
parameter is in addition to the Number of Observed Vehicles.

Max
Is the maximum distance allowed for looking ahead. It needs to be
extended only in rare occasions (such as modeling railways).

Example:

If modeling cyclists that are allowed to overtake each within the
same lane, the min. Look Ahead Distance should be set to a value
greater than O in order to prevent vehicles passing through one
another because there might be more than two cycles on the
same link coordinate at the same time and thus the parameter
Number of Observed Vehicles is not sufficient.

Number of Observed Vehicles

Affects how well vehicles in the network can predict other vehicles
movements and react accordingly. As some of the network objects are
internally modeled as vehicles it might be useful to increase this value if
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there are several cross sections of network objects within a short distance.
However, the simulation will run slower with higher values.

Look Back Distance

Defines the distance that a vehicle can see backwards in order to react to
other vehicles behind (within the same link).

Min.

Is important when modeling lateral vehicle behavior. Especially if
several vehicles can queue next to each other (e.g. bikes) this
value needs to be increased. The value depends on the approach
speed. In urban areas it could be 60-100 ft. (20-30m).

Max.

Is the maximum distance allowed for looking backward. In
networks with many small meshes, for example with many
connectors over a short distance, the simulation speed can be
improved if the maximum look back distance is reduced from the
default value.

Temporary lack of attention

Affects a reaction time based on the duration and probability of the vehicle
composition of observing the duration. This value should not be modified
as an initial calibration technique.

Smooth close up behavior:

If this option is checked, vehicles slow down more evenly when
approaching a standing obstacle. Starting at the maximum look ahead
distance from the standing obstacle a trailing vehicle can plan to stop
there behind a leading vehicle which will stop there as well.

If this option is not checked, the trailing vehicle will use the normal
following behavior until the leading vehicle almost comes to a stand
(speed < 1 m/s). Only then, the trailing vehicle determines the final
approach behavior which can include a temporary acceleration.

Standstill distance for static obstacles:

If this option is checked, the vehicles using this behavior will use the given
value (default: 0.5 m) as standstill distance upstream of all static obstacles
except parking space, stop signs (includes signal heads, stop signs, PT
stops, priority rules, conflict areas) instead of a normal [0.5; 0.15]
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I

~

P

distributed random value. It is recommended to activate this option for PT
vehicles at PT stops with screen doors and waiting queues at fixed
positions on the platform.

If this option is not checked, the vehicles using this parameter set will use
a normal [0.5; 0.15] distributed random value as standstill distance in
meters upstream of all static obstacles.

No: 3 Name:  Freeway (Tree Lane selection)
Fotlowing  Lane Change | Lateral | Signal Control | Meso

Lok ahead ditance Car tollowing model

ey 000 m Wiedemann 99

mav: 25000 m Model patametens
2 Observed vehices Er(i(l)-{t;ndv.'l Dstance): m
l! CCY (Meadway Time). , 090‘
2 CC2 (Folluwing Variatun), s 400‘
min 000 m { CC3 {Threshold foc Entenng Folloaing) &
max: 15000 m CCA (Negative Following' Theesholgl: | -0.35|
| €CS (Pomutve Totlowing Threshold): | © )5‘
} CCE 15peed dependency of Osoiabion) ; 1 “
| CC7 (Oncitation Accelerabon): | 02% m/

Look back datance

Temporary iack of Atention

Duraton: 000 ¢

| , ‘
Probabuity 000 % 1 CCB I5tandstdl Acceleration 3150 w2

1
_ | CCO (Accelerston with 80 km/h) 150 mis2
W Sooth clodeup behavor {

Sundstll datance for

| O m
At nbitaciey
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7.3 Lane Change Parameters

The lane change tab of the driver behavior window includes parameters |
that can be set to calibrate the lane change model in Vissim.

No.: 3 Name: Freeway (free 1ane selection)

(
following | Lane Change | Lateral | Signal Control | Meso (
General behavion  Free lane selection (
Necessary lane change (route) p
Onn Teathing vehicle '
fMadmum deceleration: 400 m/s2 300 m/s2 (
- 1 m/s2 pet distance 20000 m 20000 m (
Accepted deceleration 100 m/s2 050 nvs2 ‘
(
Waiting ime belote ditfuson 6000 s [) Creentake reduced speed ateas
Min. headway (front/rear: 050 m ¥ Advanced merging
. ) (
To dowet lane if collision tme 15 sbow 1900 5 _ Consider subsequent static \
satety alstance reduction factor: 060 " routing deasions
Maximum deceleration {or cooperative braking: 2300 mya2 P
\
| Cooperative lane change )
Manmum spoed difference: 1050 m/n )
Mavmam colliton time 1000 ¢ \
|1 Lateral cotrection of rear end posinon (
Mavimum ipeed 100 Wvh (
Active duting time pericd from 100 s untl 1000 3 after fane change start
{
(

General Behavior

Drop down menu is used to select way of overtaking (former link attribute
“right side/left side rule”).

Free Lane Selection Vehicles are allowed to overtake in any lane !

Slow Lane Rule allows overtaking in the fast lane only. (
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Necessary lane change (route):

This section is for lane changes that are required to continue on the
assigned route as opposed to merely passing a slower moving vehicle.
The decelerations can be defined for the lane changing driver (Own) as
well as for the vehicle the driver is pulling in front of (Trailing).

The range of these decelerations is defined by the Maximum and
Accepted Deceleration. In addition a reduction rate (as meters per 1 m/s?)
is used to reduce the Maximum Deceleration with increasing distance to
the emergency stop position.

Waiting time before diffusion

Defines the maximum amount of time a vehicle can wait at the emergency
stop position waiting for a gap to change lanes in order to stay on its route.
When this time is reached the vehicle is taken out of the network
(diffusion) and a warning message will be written to the error file denoting
the time and location of the removal.

Min. Headway (front/rear)

This Parameter defines the minimum distance to the vehicle in front that
must be available for a lane change in standstill condition.

To slower lane if collision time

This parameter is used only if Lane Change Behavior is set to Slow Lane
Rule. It describes the minimum time headway towards the next vehicle on
the slow lane so that a vehicle on the fast lane changes to the slower lane.

Safety distance reduction factor:

During lane changes the reduction factor is regarded, which takes effect
for the safety distance of the trailing vehicle in the new lane for the
decision whether to change lanes or not, the own safety distance during a
lane change, and the distance to the leading (slower) lane changing
vehicle during any lane change, the resulting shorter safety distance is
calculated as follows: original safety distance x reduction factor. The
default factor of 0.6 reduces the safety distance by 40%. After the lane
change, the original safety distance is regarded again.

Maximum deceleration for cooperative braking:

Defines the maximum deceleration the vehicle would use in case of
cooperative braking thus allowing a lane changing vehicle to change into
its own lane. Cooperative braking uses up to 50% of the desired
deceleration until the leading vehicle starts changing lanes, Between 50%
of the desired deceleration and this user-defined Maximum deceleration.
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Typically, deceleration during lane changes will be significantly lower than
the Maximum deceleration, since a lane changing leading vehicle will not
expect an extremely high deceleration of the trailing vehicle.

Advanced merging:

This option is checked by default in the driving parameter sets in newly
created networks, but not in existing versions of input files which have
been created with previous Vissim versions. The current option setting
affects any necessary lane change towards the next connector along the
vehicle’s route. If this option is checked, this will allow more vehicles to
change lanes earlier; thus, the capacity will increase and the probability of
standing vehicles waiting for a lane change will be reduced.

Cooperative lane change:

If vehicle A observes that a leading vehicle B on the adjacent lane wants
to change to the (A) lane, then vehicle A will try to change lanes itself to
lane (B) in order to make room for B.

\Vehicle A behaves as if it had to change lanes for a connector far in the
distance, accepting only the base values for necessary lane changes
(Accepted deceleration) for its own deceleration and for the trailing vehicle
C on the new lane.

Vehicle A does not change cooperatively to a lane which is less suited for
its own route, and it does not change lanes cooperatively if vehicle B is
more than 10.80 km/h ( =3 m/s) faster or if the collision time would exceed
10 seconds with the speed of vehicle A increased by 10.80 km/h.
Optionally, user-defined values can be regarded instead for these two
parameters.

Maximum speed difference in [m/s]:

If option Cooperative lane change has been checked, the user-
defined maximum speed difference value is taken into account.

Maximum collision time in [simulation seconds]:

If option Cooperative lane change has been checked, the user-
defined maximum collision time value is taken into account.

Lateral correction of rear end position:

For a lane change that takes place at a lower speed than specified in the
Maximum speed box, the vehicle's end moves laterally and the vehicle is
parallel to the middle of the lane at the end of the lane change.

Maximum speed:
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Speed up to which the correction of the rear end position should
take place. Default value 3km/h.

Active during time period from:

Time after the start of the lane change at which the lateral movement of
the rear end position should start, default value 1.0 s. Time after the start
of the lane change at which the lateral movement of the rear end position
should end. The value includes 3 s for the lane change of the front end,
default value 10.0.

There are always questions about acceptable ranges of the car following
and lane changing parameters. The objective of this training is not to
suggest a prescriptive solution but to introduce some accredited
references which suggest ranges for these values. Here are some of the
references in this regard:
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8

Model Calibration Tactics

After the model's geometry and demand have been created a certain
amount of calibration might be required. This section will be diving a bit
deeper into how a few of the parameters affect the simulation.

8.1 Weaving Sections

In this section we will look at modeling custom following and lane change
behaviors for a freeway weaving section. In these areas drivers tend to
change their behaviors; they often become more aggressive and more
attentive.

To emulate weaving behaviors Vissim modelers will create a unique
driving behavior and adjust some key parameters. This driving behavior
will only be applied to the weaving sections of the network using Link
Behavior Types.

8.1.1 Observed Vehicles (Following Tab)

The default setting in the freeway driving behavior is 2. This means at any
particular point in time a Vissim vehicle is only tracking the two closest
objects to it; typically the vehicle directly in front and then one other.

During weaving sections, with increased activity comes a need to track |
more vehicles at a given time. Therefore we will increase the number of
observed vehicles so Vissim vehicles will track more activity.

8.1.2 Cooperative Lane Change (Lane Change Tab)
#

By default this is not active; meaning if a vehicle on the main line sees a
merging vehicle, it will not attempt to provide space by changing lanes.
Once this is checked we will see more vehicles moving over to allow
merging vehicles to make lane changes.

This is a key calibration for controlling how congestion is spread laterally
to the left most lanes in a weaving section:

Higher values for Max speed difference means increased
congestion in the left lanes.

Lower values will see speeds i-n the left lanes closer to free-flow.
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8.1.3 Safety Distance Reduction Factor (Lane Change)
= = — ——— ——— — — |

Remember:
Safety Distance = CCO + CC1 * speed
The reduction factor is a constant multiplier:
Safety Distance (during lane changes) =r * (CCO + CC1 * speed)

This means that the safety distance reduction factor has a direct
correlation to the aggressiveness of the vehicles during lane changes.

Values less than 1.0 make drivers more aggressive during lane
changes.

Values greater than 1.0 will make drivers more conservative
during lane changes.

A value of 1.0 means that drivers are neither more aggressive or
more conservative.

8.1.4 Activity Lesson 8-1

“Driving Behavior and Link Capacity”
= e =~ _——— ————————— 0 ama— |

Objective:

This activity helps demonstrate how we might calibrate a weaving
section’s driving behavior and measure capacity in Vissim.

It is important to note that Capacity is an output in Vissim rather than an
input.

Objects Used:

. Driving Behaviors

. Link Behavior Types

. Link Segment Results
Procedure:

1. Open the file “8-1.inpx”
2. Save as a new file
3. Complete the task below

Task:

1. Run a simulation. Notice the merging behavior on link 36.
The default driver behavior parameters are not allowing for aggressive
enough merging behavior to accommodate the high merging volumes
of this example.
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10.
11.

Stop the Simulation.

Modify the Driver Behavior parameters
a. Open Base Data —»Driving Behavior
b. Right-Click on #3 “Freeway”.

c. Via the context menu duplicate the parameter set and name
the new set “Merge.”

Make the following parameter changes to the Merge parameter set:
e CC1=12+/-00
e (CC2= 20
o Trailing Vehicle -1 ft/s” per distance = 100 ft
e Waiting time before diffusion = 99999
e Safety distance reduction factor: 0.3
e Check cooperate lane change
Create a new link behavior type
a. Open Base Data—Link Behavior types
b. Create a new link behavior type called Merge.

c. Update the default driver behavior to the newly created driver
behavior parameter set Merge.

Update the link behavior for Link #36.

r—

Link Data

Mo.: 36 MName: Iﬁier_stateQO '

Num, of lanes: 5 Behavior type: |6: Merge

[

Run the simulation and observe the changes in operation.

In the Other tab and activate the “Link Evaluation”, make the segment '
length 600 ft.

Use Link Evaluation output to create a speed-flow curve for this
segment to evaluate the saturation flow.

a. Select Evaluation—>Configuration
b. Set the parameters as follows by lane segment.

ks | | of sew| 5[ Hee. ]
Run a simulation to generate the results attributes.
Review the results
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a. Go to Evaluation—>Results Lists—»Link Segments. The list

table is already configured to display the volume and speed
result attributes.

b. Copy ® the data to the clipboard.

12. Open Excel, then paste the results list using the Paste—Use text
Import Wizard:

Paste Options:

Al
Use Text Import Wizard..,

Import the table semi-colon delimited. Then in Excel plot the volume and
speed columns using a scatter plot to generate the speed flow curve.

Speed Flow Curve
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8.2 Speed Profiles \

We have already discussed creating a basic speed distribution with an !
85th percentile speed. This type of distribution will suffice for many model
types. However, in freeway models especially, accurate speed "
representation plays an important role in the overall results. Therefore a (

more refined speed profile will be necessary.

1. The first task will be to gather speed data. This can be done in
a number of ways and will vary from study to study. )

2 Once the data is collected and organized you will need to
create a speed profile. (
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3. Once you have the speed profile, gather the profile data into a
Cumulative Speed Distribution.

4. From the Cumulative Speed Distribution you can create the Desired
Speed Distribution

No: 35 Name: 39 mph Distribution

2500 mph 7500 mph

LN D A D A R D R R A A R Y R N |

0.00

25.0
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8.21 Activity Lesson 8-2
“Creating a Speed Profile”

Objective:
By the end of this activity we should be able to create a refined speed
distribution from a speed profile.

Objects Used:
° Desired Speed Distributions

Procedure:

1. Open the file “8-2.inpx”
2. Save asa new file

3. Complete the task below

Task: Speed Profile

1. Using the Data shown
here form a cumulative
speed distribution

8

31.7%

&
8

27.7%

8

2. From the cumulative 18.6%

Speed Distribution create
a desired speed
distribution.
a. Open the Base
Data menu
b. Select
Distributions Speed (mph)
—Desired Speed
Press the + button to create a new distribution
Set the min to 30 mph
Set the max to 70 mph
f. Create intermediate points for each 5 mph threshold.
3. Assign the new speed distribution to the eastbound traffic.
4 Run a simulation and compare the average speeds of the eastbound
traffic to those of the westbound traffic.
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8.3 Conflict Area Gap Acceptance
e e ———)

Gap acceptance in Vissim can be obscure because many users are
looking for a critical gap entry field. For conflict areas Vissim does not
have “critical gap”.

At a crossing conflict Vissim uses Front Gap and Rear Gap both with
defaults of 0.5s.

The resulting “critical gap” at this conflict is the summation of the front and
rear gaps in addition to the amount of time it takes to cross the intersection
(dependent on the vehicle type's acceleration model).

For example:

Say it takes a passenger car 2.25 seconds to clear a conflict from a
stopped position at a crossing conflict. The conflict area is configured to
use the default front gap and rear gap. In this case:

Critical gap = front gap + travel time + rear gap
OR
Critical Gap = 0.5 + 2.25 + 0.5 = 3.25 seconds

We can adjust the critical gap acceptance by adjusting the front and rear
gap; higher values directly increase the critical gap and lower values
directly decrease the critical gap.

In other words, higher values create more conservative drivers at this
conflict and lower values create more aggressive drivers at that conflict.
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8.3.1 Activity Lesson 8-3
“Calibrating a Conflict Area”

Objective:

By the end of this activity we should be able to adjust the conflict area
attributes to calibrate gap acceptance.

Objects Used:

o Conflict areas
Procedure:
1. Open the file “8-3.inpx”
2. Save as a new file

3. Complete the task below

Task:
1. Test the Default Values.
a. Run a simulation with the default values
b. Compare the results to the HCM curve.
2. Test a more aggressive Safety Distance Factor
a. Adjust the Safety Distance Factor to 1.0
b. Run a simulation.
c. Compare the results to the HCM curve.
3. Test a more aggressive Front Gap
a. Adjust the Front Gap to 0.25
b. Run a simulation.
c. Compare the results to the HCM curve.

4. Further adjust the Safety Distance Factor and Front Gap to calibrate
the conflict area to the HCM trend line.
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8.4 Volumes By Time Interval
“

Previously we learned how to create a vehicle input that generates
constant demand. However demand is rarely constant. In this section we
will learn how to take a demand curve and apply it to our vehicle inputs.

1. Gather our demand data.

2. Determine the resolution of the data; how often will the
numbers change? Many modelers use either 60 or 15 minute
intervals. Some go as far as to create 5 minute intervals. We
can also use a combination (non-uniform intervals) where
some are 15 minutes long and others are 20 or 10.

3. Create the time intervals in Vissim
a. Open the Base Data Menu
b. Select Time intervals to open the time intervals list

c. Inthe list use the pull-down menu to select Vehicle
Inputs

d. Use the + button to add new intervals

e. Define each interval, in simulation seconds
Open the Vehicle Inputs List
In the list open the attribute selection window

Add the volume and composition time intervals to the list

N o o s

In the List define the Volumes (veh/hr) for each time interval.
Vissim will automatically scale the input volumes.

For example we have a 15-minute interval and define a volume of 3000.
That is 3000 veh/hr so Vissim will input roughly 750 vehicles in that time
interval
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8.4.1 Activity Lesson 8-4
“Input Volumes by Time Interval”

Objective:
By the end of this activity we should be able to create a refined demand
profile based on 15-minute volume data

Objects Used:

o Time intervals
° Vehicle Inputs
Procedure:

1. Open the file "8-4.inpx”
2. Save as a new file
3. Complete the task below

Task:
1. Create volume time intervals for each 15-minute period.

a. Open the Base Data menu
b. Select Time Intervals
c. Using the pull-down list select Vehicle Inputs
d. Create four 900 second intervals
2. Adjust the volumes on the Vehicle inputs.
a. Open the Vehicle Inputs List
b. Make sure the list shows all time intervals

i Click the select attributes button (¥ )
i. In the list on the left select Volumes

iii. Press the m button to add the attributes to the list on
the right

iv. Click OK

c. We may need to unlock the subsequent time intervals

i. Using the pull-down menu select the Vehicle Inputs
By Time Interval sub-list.

i. Select all inputs in the list on the left

ii. Uncheck any row that has the box Continuous

checked
d. Copy the following table into the volume entries.
Input 0-15 | 15-30 | 30-45 | 45-60

WB On-Ramp | 1000 | 1000 1000 1000
WB Main Line | 3000 | 3000 3000 3000
EB On-Ramp 750 1000 1250 1000
EB Main Line | 2250 | 3000 3750 3000

3. Run a simulation
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